1 • Introduction to the Dionex AS-DV ................. 1
  1.1 Overview of the Dionex AS-DV ......................... 1
  1.2 About This Manual ......................................... 2
  1.3 Safety and Regulatory Information ..................... 3
    1.3.1 Safety Messages and Notes ............................ 3
    1.3.2 Safety Symbols ....................................... 5
  1.4 Deionized Water Requirements for IC .................... 5
    1.4.1 Declaration of Conformity ............................ 6

2 • Description .................................................. 7
  2.1 Operating Features ......................................... 7
    2.1.1 Front View ........................................... 7
    2.1.2 Front Interior Features ............................... 11
    2.1.3 Rear Panel ........................................... 12
  2.2 Dionex AS-DV Operating Principles ..................... 14
    2.2.1 Sampling Operating Principles ....................... 14
    2.2.2 Rinsing Operating Principles ......................... 15
    2.2.3 Optional High-Pressure Valve Operating Principles .... 15
  2.3 Chromeleon Software ...................................... 18
    2.3.1 Software Control Modes ............................... 18
    2.3.2 System Wellness ...................................... 19
# 3 • Operation and Maintenance

3.1 Preparing the Sample Vials

3.1.1 Cleaning the Vials

3.1.2 Cleaning the Caps

3.1.3 Cleaning the Filter Caps

3.1.4 Filling the Vials and Installing the Caps

3.2 Turning on the Power

3.3 Loading the Vial Carousel

3.4 Connecting to Chromeleon

3.4.1 Connecting to Chromeleon 7

3.4.2 Connecting to Chromeleon 6.8

3.5 Creating a Chromeleon Instrument Method or Program

3.5.1 Creating an Instrument or a Program with the Wizard

3.5.2 Dionex AS-DV General Parameters

3.5.3 Basic Edit Mode

3.5.4 Advanced Edit Mode

3.6 Creating a Chromeleon Sequence

3.7 Starting a Run

3.8 Operating Details

3.8.1 Interrupting the Autosampler

3.8.2 Specifying a Bleed

3.8.3 Specifying a Rinse

3.8.4 Returning to a Vial

3.8.5 Replacing Vials During a Run
3.8.6 Inserting a Priority Sample ............................................ 48
3.8.7 Controlling the Delivery Volume ................................. 49
3.8.8 Using Sample Overlap Mode ...................................... 53
3.9 Routine Maintenance ...................................................... 56
  3.9.1 Periodic Maintenance .............................................. 56
  3.9.2 Annual Maintenance .............................................. 56

4 • Troubleshooting ............................................................. 57
  4.1 Alarms and Error Conditions .................................... 57
  4.2 Liquid Leaks ................................................................. 64
  4.3 Poor Peak Reproducibility ............................................ 65
  4.4 Unexpected or Extraneous Peaks Detected ....................... 66
  4.5 Sample Not Loaded ..................................................... 66
  4.6 Autosampler Stops Operating ....................................... 67
  4.7 Excessive Backpressure .............................................. 67
  4.8 Autosampler Jammed .................................................... 68

5 • Service ........................................................................ 69
  5.1 Replacing Tubing and Fittings .................................... 69
  5.2 Removing the Carousel ............................................... 70
  5.3 Replacing the Sampling Tip and Tubing ......................... 74
  5.4 Manually Raising the Sampling Head ......................... 77
  5.5 Rebuilding a High-Pressure Valve ............................... 79
  5.6 Replacing a High-Pressure Valve Pod ......................... 81
5.7 Replacing the Main Power Fuses ................................................. 84

A • Specifications ................................................................. 85
A.1 Electrical ................................................................. 85
A.2 Physical ................................................................. 85
A.3 Environmental ......................................................... 85
A.4 Sampling Mechanism ................................................. 86
A.5 Sample Vials ........................................................... 86

B • Installation ................................................................. 87
B.1 Facility Requirements .................................................. 87
B.2 Unpacking the Dionex AS-DV ........................................ 87
B.3 Connecting the Dionex AS-DV Sample Out Line ...................... 88
  B.3.1 Connecting the Sample Out Line Directly to an IC System ... 89
  B.3.2 Connecting the Sample Out Line to the Optional
       High-Pressure Valve .................................................. 90
B.4 Connecting the Drain Line .............................................. 94
B.5 Installing Chromeleon and the Chromeleon Software License .... 95
B.6 Connecting the Dionex AS-DV to the Chromeleon PC ............... 95
B.7 Connecting the Power Cord ............................................ 96
B.8 Setting Up Chromeleon ................................................ 97
  B.8.1 Installing the Dionex AS-DV Device Driver ............... 97
  B.8.2 Configuring the Dionex AS-DV in Chromeleon .......... 98
  B.8.3 Connecting to the ePanel Set or Panel Tabset .......... 100
Contents

B.8.4 Verifying Chromleon Communication ................. 102
B.8.5 Setting Up the Dionex AS-DV for Simultaneous Injections . 102

C • Relay Control ................................................. 103

C.1 TTL Input Function ........................................... 104
C.1.1 Load Cycle Timing ......................................... 104
C.1.2 Delivery Speed, Flush Factor, and TTL Homing Delay Settings ........................................... 104
C.1.3 TTL Input Control Modes .................................... 105

C.2 Connecting to the Relay Output and TTL Input ................. 108

C.3 Example Connections for Stand-Alone Operation ................ 109

C.4 Controlling the Relay Output .................................... 110

D • Reordering Information ........................................ 115

Index
1 • Introduction to the Dionex AS-DV

1.1 Overview of the Dionex AS-DV

The Thermo Scientific Dionex™ AS-DV Autosampler is a compact autosampler that is capable of delivering between 0.1 mL and 5.0 mL of sample (in 0.1 mL increments) to the sample loop or concentrator column in an ion chromatography (IC) system. The Dionex AS-DV is compatible with the Thermo Scientific Dionex ICS-5000, ICS-2100, ICS-1600, ICS-1100, and ICS-900 systems, as well as legacy IC systems.

The Dionex AS-DV holds 50 vials (either 0.5 mL or 5.0 mL, or a combination of the two sizes). Vials can be sampled in any order and multiple samples can be taken from each vial. The autosampler remembers the vial size and volume delivered for each vial position, allowing multiple samples to be taken from a vial non-sequentially.

The unique Thermo Scientific Dionex PolyVial™ sample vial incorporates a cap that acts as a simple piston to force sample out of the vial. This eliminates the need for an external sampling pump. Sample can be delivered to a sample loop or a concentrator column with backpressures up to 690 kPa (100 psi). Caps with a 20 μm filter are available to remove solid materials from the sample before injection.

The Dionex AS-DV can be configured either without a valve (the standard configuration) or with an optional 6-port high-pressure valve or 10-port high pressure valve.

The Dionex AS-DV is controlled with a PC configured with Thermo Scientific Dionex Chromeleon® 7 Chromatography Data System (release 7.0 or later) or Chromeleon 6.8 Chromatography Data System (release 6.80 SR6a or later). The autosampler connects to the Chromeleon PC with a USB cable.

The Dionex AS-DV can also be operated under relay control from a device capable of executing timed events, such as a previous generation IC system without USB connectivity.
The Dionex AS-DV can be ordered with the accessories needed for sampling from either 0.5 mL vials or 5.0 mL vials:

- Order P/N 068908 to sample from 0.5 mL vials (Ship Kit P/N AAA-071115)
- Order P/N 068907 to sample from 5.0 mL vials (Ship Kit P/N 068887)

**NOTE** Vials must be ordered separately.

### 1.2 About This Manual

The electronic version (i.e., PDF file) of the Dionex AS-DV operator’s manual contains numerous links that you can click to take you to other locations within the file. These links include:

- Table of contents entries
- Index entries
- Cross-references (underlined in blue) to sections, figures, tables, etc.

If you are not familiar with how to navigate PDF files, refer to the Help system for Adobe® Acrobat® or Adobe Reader® for assistance.

**Chapter 1, Introduction**
Introduces the Dionex AS-DV; explains the conventions used in this manual, including safety-related information.

**Chapter 2, Description**
Describes Dionex AS-DV operating features and the software required for autosampler control.

**Chapter 3, Operation and Maintenance**
Provides operating instructions for the Dionex AS-DV and describes routine preventive maintenance procedures.

**Chapter 4, Troubleshooting**
Lists problems and presents step-by-step procedures for how to isolate and eliminate the cause of each problem.

**Chapter 5, Service**
Provides step-by-step instructions for routine service and parts replacement procedures that the user can perform.

**Appendix A, Specifications**
Contains the Dionex AS-DV specifications and facility requirements.

**Appendix B, Installation**
Provides specifications and installation site requirements for the Dionex AS-DV.
1.3 Safety and Regulatory Information

The Dionex AS-DV was manufactured by Thermo Fisher Scientific at the following location: 527 Lakeside Drive, Sunnyvale, CA 94088-3603 U.S.A. The Dionex AS-DV is designed for use with ion chromatography (IC) systems and should not be used for any other purpose. Thermo Scientific does not recommend the use of flammable solvents in the Dionex AS-DV vials. Operation of a Dionex AS-DV in a manner not specified by Thermo Scientific may result in personal injury.

If there is a question regarding appropriate usage, contact Technical Support for Dionex products. In the U.S. and Canada, call 1-800-346-6390. Outside the U.S. and Canada, call the nearest Thermo Fisher Scientific office.

1.3.1 Safety Messages and Notes

This manual contains warnings and precautionary statements that, when properly followed, can prevent personal injury to the operator and/or damage to the Dionex AS-DV. Safety messages appear in bold type and are accompanied by icons, as shown here.

- **DANGER**
  Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury.

- **WARNING**
  Indicates a potentially hazardous situation which, if not avoided, may result in death or serious injury.

- **CAUTION**
  Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury. Also used to identify a situation or practice that may seriously damage the instrument, but will not cause injury.

- **IMPORTANT**
  Indicates that the function or process of the instrument may be impaired. Operation does not constitute a hazard.
Messages d'avertissement en français

Signale une situation de danger immédiat qui, si elle n'est pas évitée, entraînera des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée, pourrait entraîner des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée, pourrait entraîner des blessures mineures à modérées. Également utilisé pour signaler une situation ou une pratique qui pourrait gravement endommager l'instrument mais qui n'entraînera pas de blessures.

Warnhinweise in Deutsch

Bedeutet unmittelbare Gefahr. Mißachtung kann zum Tod oder schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zum Tod oder schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zu kleineren oder mittelschweren Verletzungen führen. Wird auch verwendet, wenn eine Situation zu schweren Schäden am Gerät führen kann, jedoch keine Verletzungsgefahr besteht.

Informational messages also appear throughout this manual. These are labeled NOTE and are in bold type:

NOTE NOTES call attention to certain information. They alert you to an unexpected result of an action, suggest how to optimize instrument performance, etc.
1.3.2 Safety Symbols

The symbols below appear on the Dionex AS-DV or on Dionex AS-DV labels.

- Alternating current
- Primary protective conductor terminal
- Secondary protective conductor terminal
- Power supply is on
- Power supply is off
- Indicates a potential hazard. Refer to this operator’s manual for an explanation of the hazard and how to proceed.

1.4 Deionized Water Requirements for IC

For all procedures requiring deionized water, use ASTM Type I (18 megohm-cm) filtered and deionized water that meets the specifications listed in Table 1-1.

<table>
<thead>
<tr>
<th>Contaminant</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ions–Resistivity</td>
<td>&gt;18.0 (megohm-cm)</td>
</tr>
<tr>
<td>Organics–TOC</td>
<td>&lt;10 ppb</td>
</tr>
<tr>
<td>Iron/Transition Metals*</td>
<td>&lt;1 ppb</td>
</tr>
<tr>
<td>Pyrogens</td>
<td>&lt;0.03 (Eu/mL)</td>
</tr>
<tr>
<td>Particulates &gt; 0.2 µm</td>
<td>&lt;1 (units/mL)</td>
</tr>
<tr>
<td>Colloids–Silica</td>
<td>&lt;10 ppb</td>
</tr>
<tr>
<td>Bacteria</td>
<td>&lt;1 (cfu/mL)</td>
</tr>
</tbody>
</table>

* Iron/transition metal content not specified for ASTM Type I Water

Table 1-1. ASTM Filtered, Type I Deionized Water Specifications
1.4.1 Declaration of Conformity

The cETLus and CE marks on the Dionex AS-DV model/data label indicate that the autosampler is in compliance with the following standards.

MANUFACTURERS DECLARATION OF CONFORMITY

Product Identification
- Product: Automated Fluid Sampler
- Brand: Dionex
- Model: AS_DV

Manufacturer
Dionex Corporation
1228 Titan Way
Sunnyvale, California 94088
USA

Representative
Larry McNary
Dionex Corporation
1228 Titan Way
Sunnyvale, CA, USA 94085

Function:
Director, Engineering

Means of conformity
The product is in conformity to the listed directives and standards:

EMC Directive: 89/336/EEC

Safety Standards:
- IEC/EN 61010-1:2001
- UL 61010-1 2004/07/12 revised 2005/07/12
- CAN/CSA-C22.2 No. 61010.1-2nd edition 2004/07/01

EMC Standards:
EN 61326-1:2006

Signature of Representative:

Name: Larry McNary
Place: Sunnyvale, CA, USA
Date: 23 Feb. 2009
2 • Description

2.1 Operating Features

2.1.1 Front View

Figure 2-1 illustrates the main operating features of the Dionex AS-DV.
LED Display

![LED Display Diagram]

*Figure 2-2. Status LEDs*

Four LEDs on the Dionex AS-DV front panel (see Figure 2-2) indicate the status of the following autosampler functions.

- **CONNECTED**
  This LED is on when the Dionex AS-DV is connected to Chromeleon.

- **ALARM**
  This LED flashes when a problem has occurred. Check the Chromeleon audit trail for the cause.

- **CAROUSEL**
  This LED is on when the carousel is engaged.

- **POWER**
  This LED is on when the Dionex AS-DV power is on.

Other status information and alarm messages are displayed in the audit trail in Chromeleon. For a description of these messages, see Section 4.1.

**Sampling Mechanism**

The sampling mechanism consists of a sampling head tower, a vial carousel, and a carousel cover (see Figure 2-1).

- The sampling head tower delivers sample from the sample vials to the sample out line, which exits the front of the Dionex AS-DV (see Section 2.1.2). For a description of how the sampling mechanism operates, see Section 2.2.1.

- The carousel holds the PolyVials containing sample or rinse solution. Vial numbers are molded into the top of the carousel to indicate the sampling position. Vials can be placed in any order in the carousel. The Chromeleon sequence controls the order in which sampling occurs. For a description of how to create a sequence, see Section 3.6.

Sensors in the sampling mechanism detect the presence (and the size) of the vial under the sampling head tower.
The carousel cover protects light-sensitive samples and the interior of the Dionex AS-DV. To access the sampling head tower and carousel, lift up the cover.

**To avoid trapping dust particles in the vial caps, always operate the Dionex AS-DV with the carousel cover closed.**

**Carousel Release Button**

The *Carousel Release* button on the inside of the chassis performs two functions:

- Engages and disengages the carousel from the motor.
- Resets vial memory (clears presence, vial size, and volume remaining information). Before starting a run, always press *Carousel Release* to reset the vial information.

**PolyVials**

The vial carousel holds up to 50 0.5 mL or 5.0 mL disposable plastic PolyVials or a combination of the two sizes. Vial adapters (P/N 071901, package of 50) are required to load 0.5 mL vials into the carousel. Adapters are included in the Dionex AS-DV Ship Kit for 0.5 mL vials (P/N AAA-071115). PolyVials serve both rinse and sample functions.

*NOTE* Thermo Fisher Scientific does not recommend the use of flammable solvents in the Dionex AS-DV vials.

**Vial Caps**

Vial caps perform an important function in sample loading (see *Section 2.2.1*). They also minimize evaporation, contamination, or spills of sample while awaiting use. Caps with 20 μm filters are available. The filter traps particulates that might contaminate the analytical system. PolyVials and caps can be used for loading sample to either a sample loop or a concentrator column. An insertion tool (P/N 037987), included in the
Dionex AS-DV Operator’s Manual

Dionex AS-DV Ship Kit, simplifies insertion of the caps. Appendix D contains part numbers for PolyVials, vial caps, and other accessories.

Vial Adapters

Before loading a 0.5 mL vial into the carousel, insert a vial adapter (P/N 071901, package of 50) onto the vial (see Figure 2-3). After you load the vial into the carousel, twist the adapter slightly to the right to lock the adapter in place.

![Vial Adapter for 0.5 mL Vials](image)

**Figure 2-3. Vial Adapter for 0.5 mL Vials**

Vial Tray

Vial trays (either for 0.5 mL or 5.0 mL vials) are included in the respective Dionex AS-DV Ship Kit (P/N AAA-071115, Ship Kit for 0.5 mL vials; P/N 068887, Ship Kit for 5.0 mL vials). Place vials into the tray and then fill them until the liquid in the vials reaches the top of the tray.
2.1.2 Front Interior Features

Figure 2-5 illustrates the front interior of the Dionex AS-DV. To access the front interior, remove the front cover by gripping the indentations at each side and pulling the cover straight off toward you.
Sample Out Line

The sample out line is routed from the sampling mechanism through an aperture in the front interior. From there, it is connected either to the high-pressure valve in the Dionex AS-DV (if installed) or to the injection valve in the IC system.

High-Pressure Valve (Optional)

Either a 6-port or a 10-port high-pressure valve can be installed in the Dionex AS-DV. The valve can be configured to operate as an injection valve or an auxiliary valve in an application (for example, it can be used as a bleed valve or to load a concentrator column).

For details about operation of the high-pressure valve, see Section 2.2.3. For valve installation instructions, see Section B.3.2.
2.1.3 Rear Panel

Figure 2-6 shows the features on the rear of the Dionex AS-DV.

Drain

Liquid from any spills exits the Dionex AS-DV enclosure through the DRAIN port. Connect a drain hose (P/N 055075) to the port and place the free end of the hose into either a waste container or an appropriate drain. The drain hose is included in the Dionex AS-DV Ship Kit.

Neutralize acidic and caustic wastes before disposal. Dispose of all wastes in accordance with local regulations.

Neutralisez les déchets acides ou caustiques avant de les jeter. Jetez les déchets aux règlements locaux.

Neutralisieren Sie säurehaltige und ätzende Abfälle vor ihrer Entsorgung. Entsorgen Sie alle Abfälle entsprechend den lokalen Bestimmungen.
USB Connector

The USB connector connects the Dionex AS-DV to the PC on which Chromeleon is installed. Connect a USB cable between the USB connector on the Dionex AS-DV and a USB port on the PC. Alternatively, the Dionex AS-DV can be connected to a hub or an IC system with a USB port. For USB connection instructions, see Section B.6.

Relay and TTL Connector

The relay output can be used to control functions in other TTL- or relay-controllable devices. The TTL input can be used to start the Dionex AS-DV load cycle. For connection and operation instructions, see Appendix C.

Power Switch, Fuse Drawer, and Power Receptacle

- The power switch provides on/off control of power to the Dionex AS-DV.
- The fuse drawer contains two fast-blow IEC 127 fuses rated 3.15 A (P/N 954745). For instructions on how to change the fuses, see Section 5.7.
- The power supply cord plugs into the IEC 320 three-prong receptacle.

! CAUTION

The power supply cord is used as the main disconnect device. Make sure the socket-outlet is located near the Dionex AS-DV and is easily accessible.

! MISE EN GARDE

Le cordon d'alimentation principal est utilisé comme dispositif principal de débranchement. Veillez à ce que la prise de base soit située/installée près du module et facilement accessible.

! VORSICHT

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung. Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und leicht zugänglich ist.
2.2 Dionex AS-DV Operating Principles

2.2.1 Sampling Operating Principles

The sampling head tower (see Figure 2-1) consists of a motor-driven needle, with a sampling tip on the end, that moves down to engage the top of the vial cap.

As the needle moves downward, the cap is gradually pushed into the vial (see Figure 2-7), forcing the liquid through the filter (if present) and into the sample out line. The moving cap acts as a piston to force the liquid from the vial. This allows samples to be loaded without the use of an external sampling pump. The concave bottom of the vial cap traps air, so that it can be expelled with any excess sample above the fill line. In addition, the shape exactly matches the convex bottom of the sample vial; when the cap is pushed completely into the vial, virtually all of the sample is expelled.

The socket for the sampling tip is identical on both sizes of caps to allow mating with the tip of the sampler head. The sampling head speed (delivery speed) is set in Chromeleon (see Section 3.5).

Figure 2-7. PolyVial, Cap, and Sampling Tip Features
During a bleed, the cap is pushed into the vial, starting from its topmost position and stopping when it reaches the position at which the Dionex AS-DV begins measuring the injection volume.

### 2.2.2 Rinsing Operating Principles

To deliver a rinse, the Dionex AS-DV performs the basic operation used for delivering a sample. A vial containing the rinse liquid is moved to the sampling head tower and the rinse liquid is delivered from the vial through the sample out line. You can intermix sample vials and rinse vials in any order in the carousel. The position of the rinse vial in the carousel and the volume of rinse liquid to deliver is defined in Chromeleon.

You can also designate a range of vial positions to be reserved for rinse vial use only. The rinse vial range is defined in the Chromeleon 7 Instrument Configuration Manager or the Chromeleon 6.8 Server Configuration program (see Section B.8.2). When performing a rinse, the Dionex AS-DV takes the rinse liquid from the first vial in the range. If the first vial is empty, the next vial in the range is used, and so on.

To define rinse cycles in Chromeleon, see Section 3.8.3.

### 2.2.3 Optional High-Pressure Valve Operating Principles

A high-pressure valve can be installed in the Dionex AS-DV. Two models are available: 6-port and 10-port. Both models are electrically-activated, 2-position valves. See the table below for valve kit part numbers.

<table>
<thead>
<tr>
<th>Valve Kit Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>6-Port High-Pressure Valve Kit</td>
<td>068920</td>
</tr>
<tr>
<td>10-Port High-Pressure Valve Kit</td>
<td>068921</td>
</tr>
</tbody>
</table>

The Dionex AS-DV power must be turned off before you install or rebuild a valve. If the power is on when you connect or disconnect the valve cable, the Dionex AS-DV may be damaged.
**Operation as an Application Valve**

The optional valve can be configured for various application functions, including sample injection, concentrator column loading, or matrix elimination.

Plumbing configurations for the valves depend on the components to be connected and the application to be run. Refer to the appropriate Thermo Scientific Dionex Application Note for more information.

**Operation as a Bleed Valve**

When the optional valve is configured as a bleed valve (see [Figure 2-10](#) and [Figure 2-11](#)), the valve directs excess sample and any air trapped in the sample vial to waste. Excess sample is any sample above the fill line on the vial (see [Figure 2-7](#)). After the initial bleed, the valve position is switched and the sample is sent directly to the injection valve in the IC system.
Figure 2-10. Optional 6-Port High-Pressure Valve: Configured as a Bleed Valve

Figure 2-11. Optional 10-Port High-Pressure Valve: Configured as a Bleed Valve
2.3 Chromeleon Software

The Dionex AS-DV is controlled with a PC configured with Chromeleon 7 Chromatography Data System or Chromeleon 6.8 Chromatography Data System.

2.3.1 Software Control Modes

Two modes of software control are available: direct control and automated control.

- With direct control, you select operating parameters and commands from the Dionex AS-DV ePanel on the Chromeleon 7 ePanel Set (see Figure 2-13) or from the Control panel on the Chromeleon 6.8 panel tabset (see Figure 2-13). Direct control commands are executed as soon as they are entered.

![Figure 2-12. Chromeleon 7 ePanel Set: Dionex AS-DV ePanel]
With automated control, you create a predefined list of commands and parameters (called an *instrument method* in Chromeleon 7 or a *program* in Chromeleon 6.8) for controlling the Dionex AS-DV. Instrument methods and programs can be created automatically (with the help of a software wizard). For information about creating an instrument method or a program, see Section 3.5.

### 2.3.2 System Wellness

System Wellness monitors the overall “health” of a chromatographic system. It provides built-in diagnostic and calibration features that help prevent unscheduled system shutdowns and assure reliable operation of system devices. Use the Dionex AS-DV Wellness Panel (see Figure 2-14)
to monitor the usage of replaceable parts. After replacing a part, click **Reset** to reset the **Current** counter to 0.

![Figure 2-14. Dionex AS-DV Wellness Panel](image)

- The **Carousel Jam Counter** increments each time the carousel jams.
- The **Needle Error Counter** increments each time the needle jams.
- The **Speed Adjustment Counter** increments each time the speed is adjusted due to excessive liquid backpressure or a clog.
- The **Vial Process Counter** increments each time the carousel moves a vial into place for processing.
- The **Valve Actuation Counter** increments each time the position of the high-pressure valve (if installed) is switched.
3 • Operation and Maintenance

This chapter describes routine operating and maintenance procedures for the Dionex AS-DV.

3.1 Preparing the Sample Vials

Thermo Fisher Scientific recommends thoroughly rinsing all PolyVials and caps with deionized water before filling to remove any traces of dust. Thermo Fisher Scientific DOES NOT recommend reusing vials or caps and does not guarantee their cleanliness or proper operation if reused.

When performing trace-level analyses, use the procedure in Section 3.1.1 to clean the vials. To clean the caps, use either the procedure in Section 3.1.2 (for caps without filters) or Section 3.1.3 (for caps with filters).

**IMPORTANT**

To prevent the introduction of contaminants onto the vials and filter caps, extreme care must be used in cleaning. Use only ASTM Type I (18 megohm-cm) filtered and deionized water that meets the specifications listed in Table 1-1 for the following cleaning procedures.

NOTE Before cleaning, inspect each vial and cap for damage (nicks, scratches, etc.).

3.1.1 Cleaning the Vials

1. Rinse the vials 10 times with a jet of deionized water.
2. Place the rinsed vials in a vial tray (for 0.5 mL vials, P/N 068948; for 5.0 mL vials, P/N 068947) and fill them to the top with deionized water. Do not touch the tops or interiors of the vials with your fingers.
3. Allow the vials to soak for a minimum of 24 hours (48 hours, if possible).
4. When you are ready to use a vial, empty it, and then rinse it 10 times with a jet of deionized water. Shake out any excess water and then rinse the vial twice with aliquots of sample.
3.1.2 Cleaning the Caps

Use the following procedure to clean caps without filters.

For trace-level analyses, use caps without filters to avoid introducing contaminants from the filter.

1. Place caps into a clean 4-liter polyethylene container. Fill the container three-quarters full with deionized water and cap.
2. For trace-level analyses, allow the caps to soak for a minimum of 24 hours in deionized water. This allows time for contaminants to leach out.
3. Vigorously agitate the container for 30 seconds. Drain the water. Repeat four times.
4. Refill the container to the top with deionized water and cap.
5. When you are ready to use a cap, use clean forceps to remove one from the container. Shake off any excess water and install the cap in the vial.

3.1.3 Cleaning the Filter Caps

Use the following procedure to clean caps with filters.

1. Place caps into a clean 4-liter polyethylene container. Fill the container three-quarters full with deionized water and cap.
2. Vigorously agitate the container for 30 seconds. Drain the water.
3. Empty the caps onto a clean surface.
4. Using a clean syringe, force 50 mL of deionized water through the filter frit from the top of the cap. Be sure not to dislodge the filter frit.
5. Place the rinsed caps into a clean 4-liter polyethylene container. Fill the container three-quarters full with deionized water and cap.
6. Vigorously agitate the container for 30 seconds. Drain off the water. Repeat four times.
7. Refill the container to the top with deionized water and cap.
8. When you are ready to use a cap, use forceps to remove a cap from the container. Shake off any excess water and install the cap in the vial.
3.1.4 Filling the Vials and Installing the Caps

A cap must be installed in each vial in order for the autosampler to operate correctly. A vial without a cap will be sensed as an empty position.

NOTE To prevent contamination when doing trace-level analyses, use forceps to handle the vials and caps. Also, avoid touching any surface that will be wetted with sample.

1. After rinsing, place the empty vials into a vial tray (for 0.5 mL vials, P/N 068948; for 5.0 mL vials, P/N 068947).

2. Fill the vials with either sample or rinse solution until the liquid in the vials reaches the top of the tray (see Figure 3-1). (Using a pipette simplifies filling the 0.5 mL vials.) After filling, inspect the vials to make sure no air bubbles are trapped at the bottom.

NOTE Do not underfill the vials. This may result in insufficient sample being loaded for the first injection.
3. Install the cap in the vial:
   - For a 0.5 mL vial, orient the cap with the ridged end up (see Figure 3-2) and place the cap in the vial.
   - For a 5.0 mL vial, orient the cap with the small end up (see Figure 3-2) and place the cap in the vial.

4. Use the flat end of the insertion tool (P/N 037987) (see Figure 3-3) to press the cap into the vial to the proper depth (the top of the cap is flush with the lip of the vial). The tool is provided in both Dionex AS-DV Ship Kits (for 0.5 mL vials, P/N AAA-071115; for 5.0 mL vials, P/N 068887).

   **Figure 3-2. Caps Partially Inserted in Vials**

   **Figure 3-3. Caps Installed (0.5 mL Vials Shown)**

   **NOTE** Do not use the concave end of the cap insertion tool for installing caps on Dionex AS-DV vials. It is for use with another autosampler.
5. Before loading the vial in the carousel, shake off any liquid that has been forced into the cap socket.

**NOTE** Do not use laboratory wipes to blot liquid from the cap sockets; wipes leave fibers which can accumulate in the liquid flow path and cause increased backpressure.

### 3.2 Turning on the Power

To turn on the autosampler power, press the power switch on the Dionex AS-DV rear panel (see Figure 2-6).

At power-up, the sampling needle is homed (the needle is raised) and the carousel is homed (vial position 1 is moved under the sampling head tower).

### 3.3 Loading the Vial Carousel

Raise the Dionex AS-DV top cover and press the **Carousel Release** button on the inside of the chassis. Pressing the **Carousel Release** button is required for two purposes:

- To disengage the carousel from the motor.
- To reset vial memory (clear presence, vial size, and volume remaining information). Before starting a run, always press **Carousel Release** to reset the vial information.

**IMPORTANT** Before starting a run, always press the Carousel Release button to disengage the carousel and reset the vial information. After loading the vials in the carousel, press the Carousel Release button again to engage the carousel.

1. If you are using 0.5 mL vials, insert a vial adapter onto the vial.

2. Load the vials into the carousel. You can place the vials in any order. The Chromeleon sequence (see Section 3.6) determines the order in which vials are sampled. If you are using a reserved range of positions for rinse vials (see Section B-8), place the rinse vials in the designated positions.
3. If you are using 0.5 mL vials, twist the adapter slightly to the right to lock the adapter in place in the carousel.

4. Press the **Carousel Release** button again to engage the carousel with the motor and home the carousel.

### 3.4 Connecting to Chromeleon

#### 3.4.1 Connecting to Chromeleon 7

1. Turn on the PC.

2. Check the Chromeleon 7 Instrument Controller Service icon on the Windows taskbar and start the service, if it is not already running.
   - If the icon is gray, the Instrument Controller Service is running (idle).
   - If the icon is crossed out in red, the Instrument Controller Service is not running. Right-click the icon and click **Start Chromeleon Instrument Controller**. The icon changes to gold to indicate that the Instrument Controller Service is starting.
   - If the Chromeleon Tray icon is not on the Windows taskbar, click **Start > All Programs > Chromeleon 7 > Services Manager** to open the Services Manager and click **Start Instrument Controller**.

3. To start the Chromeleon 7 client, click **Start > All Programs > Chromeleon 7 > Chromeleon 7**.

4. To display the Dionex AS-DV ePanel, click the **Instruments** category bar on the Console. Click your instrument in the Navigation
Pane. Chromeleon 7 connects to the instrument and displays the ePanel Set. Click the AS-DV tab (see Figure 3-4).

Figure 3-4. Example Chromeleon 7 ePanel Set: Dionex AS-DV ePanel
3.4.2 Connecting to Chromeleon 6.8

1. Turn on the PC.

2. Check the Chromeleon 6.8 Server Monitor icon on the Windows taskbar and start the server, if it is not already running:
   - If the icon is gray , the server is already running (idle).
   - If the icon is crossed out in red , the server is stopped. To start the server, right-click the icon and select **Start Server**. The icon changes to gold to indicate that the Chromeleon 6.8 Server is starting.
   - If the Server Monitor icon is not on the Windows taskbar, click **Start** and select **All Programs > Chromeleon > Server Monitor**. The Server Monitor opens. Click **Start** to start the server.

3. To start the Chromeleon client, click **Start** and select **All Programs > Chromeleon > Chromeleon**.

4. To display the panel tabset, select **View > Default Panel Tabset** or click the **Default Panel Tabset** toolbar button.
5. To display the Dionex AS-DV Control panel, click the AS-DV tab (see Figure 3-5).

![Figure 3-5. Example Chromeleon 6.8 Panel Tabset: Dionex AS-DV Control Panel](image)
3.5 Creating a Chromeleon Instrument Method or Program

NOTE Before creating an instrument method in Chromeleon 7 or a program in Chromeleon 6.8, be sure you have completed the Chromeleon configuration steps in Section B.8.

A Chromeleon 7 instrument method or Chromeleon 6.8 program is a list of control commands to be executed at specified times, allowing automated operation of the Dionex AS-DV. This section provides an overview of how to create an instrument method or a program with a wizard. For detailed instructions, refer to the Chromeleon Help.

3.5.1 Creating an Instrument or a Program with the Wizard

1. Verify that the Chromeleon 7 Instrument Controller Service or Chromeleon 6.8 Server is running (see Section 3.4).

2. Start the Chromeleon 7 Instrument Method Wizard or Chromeleon 6.8 Program Wizard:
   - For Chromeleon 7: On the Console, on the menu bar, click the arrow next to Create, and then click Instrument Method. Select the instrument in which the Dionex AS-DV is configured and click Next >.
   - For Chromeleon 6.8: Select File > New. Select Program File and click OK (or double-click Program File). Select the timebase in which the Dionex AS-DV is configured and click Next >.

3. If the selected instrument or timebase includes other devices (for example, a pump and detector), wizard pages for these devices are displayed before the Dionex AS-DV page.
   - On each wizard page, select the required parameters and click Next >. For details about a page, click the Help button.

4. On the Sample Preparation Options page for the Dionex AS-DV, select the preferred options.
   - a. Under Loading Mode, select either Loop (to load a sample loop) or Concentrator (to load a concentrator column).
b. If required for your application, modify the General Parameters. For details about the General Parameters, see Section 3.5.2.

c. Select the Edit Mode. Refer to the following table to determine the mode to select.

<table>
<thead>
<tr>
<th>Use Basic mode if you want to ...</th>
<th>Use Advanced mode if you want to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliver sample from the vial specified in the sequence.</td>
<td>Deliver sample from a specified vial and override the sequence.</td>
</tr>
<tr>
<td>Deliver one of the following sample volumes: volume specified in sequence, full vial, one-half of a 5 mL vial, one-third of a 5 mL vial.</td>
<td>Deliver a different volume than is available in Basic mode. The volume can be specified in 100 ( \mu \text{L} ) increments.</td>
</tr>
<tr>
<td>Deliver rinse from the rinse vial range specified in the Chromeleneon 7 Instrument Configuration Manager or Chromeleneon 6.8 Server Configuration program.</td>
<td>Deliver rinse from any vial.</td>
</tr>
<tr>
<td>Perform a bleed with the injection valve or the auxiliary valve.</td>
<td>Use the optional Dionex AS-DV valve for a function other than injection or bleed.</td>
</tr>
</tbody>
</table>

NOTE The injection valve is either the optional Dionex AS-DV high-pressure valve configured as an injection valve, or the injection valve in the chromatography system module. The auxiliary valve is the optional Dionex AS-DV valve configured as an auxiliary valve.

d. For Basic Edit Mode: Select the Volume of sample to deliver from the vial, select a Bleed option, and enable or disable a Rinse. For details about Basic Edit Mode, see Section 3.5.3.

e. For Advanced Edit Mode: Add, delete, or modify commands and parameters in the Command/Parameters table. For details about Advanced Edit Mode, see Section 3.5.4.

f. (Optional) If you selected From Sequence for the sample delivery volume, you can use the Total Volume Delivered
Estimator to estimate the volume of sample the Dionex AS-DV will deliver to the loop or concentrator column. The estimate is provided for informational purposes only. In the Loop Volume box, enter the volume of the loop installed on the injection valve.

5. After specifying the Dionex AS-DV options, click Next > and complete the remaining wizard pages.

3.5.2 Dionex AS-DV General Parameters

The following general parameters are included on the Sampler Preparation Options page.

**Delivery Speed**: Determines the speed at which the sample is delivered to the sample loop or concentrator column. The following table shows the recommended delivery speeds:

<table>
<thead>
<tr>
<th>Vial Size</th>
<th>Type</th>
<th>Speed (mL/min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small (0.5 mL)</td>
<td>Loop</td>
<td>1.6</td>
</tr>
<tr>
<td></td>
<td>Concentrator</td>
<td>0.4</td>
</tr>
<tr>
<td>Large (5.0 mL)</td>
<td>Loop</td>
<td>4.0</td>
</tr>
<tr>
<td></td>
<td>Concentrator</td>
<td>1.0</td>
</tr>
</tbody>
</table>

**Delay Volume**: Specifies the volume from the tip of the sampling needle to the injection valve. The range is 0 to 500 µL. The default value of 125 µL is appropriate for the 1.4 m (56 in) length of sample out line provided with the Dionex AS-DV. You can set the Delay Volume in the Chromeleon 7 Instrument Configuration Manager or the Chromeleon 6.8 Server Configuration program (see Section B.8.2).

**Cycle Time**: To set a uniform time between injections, select this check box and enter the time in minutes. The time between injections is never shorter than the specified cycle time. However, if the previous instrument method or program is still running when the cycle is over, cycle time will be ignored. Clear the Cycle Time check box to let the commands entered in the instrument method or program determine the time between injections.

**Flush Factor**: Chromeleon uses this parameter in the formula that determines the volume of sample delivered from the vial. The formula is shown in the Total Volume Delivered Estimator.
If **Loop Mode** is selected, enter a factor (1 to 10) to determine how much excess sample will be flushed through the sample loop. If **Concentrator Mode** is selected, the **Flush Factor** is always 1.

For details about controlling injection volumes, see [Section 3.8.7](#).

### 3.5.3 Basic Edit Mode

When you select **Basic Edit Mode** on the Sample Preparation Options page of the Instrument Method Wizard or Program Wizard, a default list of commands is displayed in the **Command/Parameters** table. The Dionex AS-DV executes the commands in the order in which they appear in the table.

**Default Basic Edit Mode Commands**

- **LoadPosition**: Switches the injection valve to the load position.
- **DeliverSample**: Delivers the injection volume to the loop. By default, the Dionex AS-DV uses the injection volume and vial position specified in the sequence.
- **EndSamplePrep**: Identifies the end of a group of sample preparation commands. This command is used when sample overlap operation is enabled in the Chromeleon 7 Instrument Configuration Manager or Chromeleon 6.8 Server Configuration program (see [Section B.8.2](#)).
- **Inject** (Chromeleon 6.8 only): Injects the sample.

You can modify the list of default commands by selecting among several options (**Volume**, **Bleed**, **Rinse**). When you select an option, Chromeleon adds the appropriate commands and parameters to the **Command/Parameters** table.

**Basic Edit Mode Options**

- **Volume**: Specifies the volume of sample to deliver from the vial to the injection valve or concentrator. For details about controlling the delivery volume, see [Section 3.8.7](#).
- **Bleed**: Delivers excess sample (and any trapped air) from the vial to waste before delivering the injection volume to the loop or concentrator column. To enable the bleed, select the valve position...
that will direct the bleed to waste. To disable the bleed, select None. For details about performing a bleed, see Section 3.8.2.

- **Rinse**: Delivers rinse fluid through the sample out line. To enable the rinse, select the check box and then specify the volume. The volume is taken from the vials in the rinse vial range, specified in the Chromeleon 7 Instrument Method Manager or Chromeleon 6.8 Server Configuration program. For details about performing a rinse, see Section 3.8.3.

### 3.5.4 Advanced Edit Mode

When you select Advanced Edit Mode on the Sample Preparation Options page of the Instrument Method Wizard or Program Wizard, you can create a customized list of commands for preparing samples. Selecting this option enables editing of the Command/Parameters table. The order in which commands appear in the Command/Parameters table determines the order in which they will be executed. You can add, delete, and modify commands and select additional commands and parameters not available in Basic Edit Mode.

**Advanced Edit Mode Commands**

- **LoadPosition**: Sets the injection valve to the load position.
- **InjectPosition**: Sets the injection valve to the inject position.
- **DeliverRinse**: Delivers rinse fluid through the sample out line. Enter the **Volume** of rinse to deliver and the **Vial** from which to take the rinse volume. For details about specifying a rinse, see Section 3.8.3.
- **DeliverSample**: Delivers sample through the sample out line. Enter the **Volume** of sample to deliver and the **Vial** from which to take the sample. If you want to take the sample from the vial position entered in the sequence, select **From Sequence**. If you want to take the sample from a particular vial and override the vial position entered in the sequence, select a specific vial number or a relative vial position (CurrentVial, CurrentVial +1, etc.). For details about controlling the delivery volume, see Section 3.8.7.
The following two commands are available only if the optional valve is installed and configured as an auxiliary valve (see Section 2.2.3).

- **AuxValve.A**: Sets the valve to the A position.
- **AuxValve.B**: Sets the valve to the B position.

**Adding, Modifying, and Deleting Commands**

- To add a command to the end of the Command/Parameters table, select the command in the Command list, enter the command parameters (if any), and click Insert (Chromeleon 7) or Append (Chromeleon 6.8).

- To add a command above another command in the Command/Parameters table, first select the command listed immediately below the intended location of the new command. Then, in the Command list, select the command to be added, enter the command parameters (if any), and click Insert. The original command remains selected, to allow you to easily add commands in chronological order.

- To change an existing command, select the command in the table, change the command parameters or select a new command, and click Change (Chromeleon 7) or Modify (Chromeleon 6.8).

- To delete a command from the Command/Parameters table, select the command and click Delete.

**Notes:**

- The EndSamplePrep command cannot be deleted.
- In Chromeleon 6.8, the Inject command is always the last command in the list; it cannot be moved or deleted.
3.6 Creating a Chromeleon Sequence

A Chromeleon sequence determines the order in which samples will be processed. This section provides an overview of how to create a sequence with the Sequence Wizard. For detailed instructions, refer to the Chromeleon Help.

Creating a Sequence with the Sequence Wizard

1. Start the Sequence Wizard:
   - For Chromeleon 7: On the Console, on the menu bar, click **Create**. Select the instrument in which the Dionex AS-DV is configured and click **Next >**.
   - For Chromeleon 6.8: Select **File > New**. Select **Sequence (using Wizard)** and click **OK**.

2. Complete each page of the wizard. For details about a page, click the **Help** button on the page.
   - On the **Unknown Injections** or **Unknown Samples** page, define one or more injections.
   - On the **Standard Samples** page (in Chromeleon 6.8 only), define one or more standard injections or click **Next >** to skip this page.
   - On the **Methods & Reporting** page, specify an instrument method or a program that includes commands for Dionex AS-DV operation (see **Section 3.5**).

Notes:

- When defining injections, enter the volume of the loop installed on the injection valve in the **Inj. Vol.** box. This ensures that calculations for the total volume delivered are correct. For details about specifying the delivery volume, see **Section 3.8.7**.
- After you complete the Sequence Wizard, you can edit the sequence. For example, you can add or delete unknowns and standards, change vial positions, or specify a different instrument method or program.
3. On the last page of the wizard, click **Finish** (Chromeleon 7) or **Done** (Chromeleon 6.8). The sequence opens on the Chromeleon 7 Console (see Figure 3-6) or in the Chromeleon 6.8 Browser (see Figure 3-7).

![Figure 3-6. Example Sequence on the Chromeleon 7 Console](image1)

![Figure 3-7. Example Sequence in the Chromeleon 6.8 Browser](image2)
3.7 Starting a Run

Before starting a run, always press the Carousel Release button to disengage the carousel and reset vial memory. After loading the vials in the carousel, press the Carousel Release button again to engage the carousel.

During a run, do not press the Carousel Release button. Doing so clears all current vial information from Dionex AS-DV memory. (During a run, the Dionex AS-DV stores the vial size installed in each carousel position and the remaining volume in each vial.)

After creating the sequence, you can start a run.

- For Chromeleon 7:
  On the Console, click Start on the Sequence Control Bar above the injection list (see Figure 3-6).

- For Chromeleon 6.8:
  On the panel tabset, click the Sequence Control tab. Click Load Sequence, open the sequence you created, and then click Start Batch.

3.8 Operating Details

3.8.1 Interrupting the Autosampler

- To interrupt the autosampler when a sequence is running in Chromeleon 7:
  On the Console, click Stop on the Sequence Control Bar above the injection list. Specify when to stop (immediately, after the current sample, or after the current sequence).

- To interrupt the autosampler when a sequence is running in Chromeleon 6.8:
  Select Batch > Stop on the Chromeleon menu bar. Select when to stop (immediately, after the current sample, or after the current sequence).
To interrupt the autosampler when a sequence is not running, click Stop on the Dionex AS-DV ePanel in Chromeleon 7 or the Dionex AS-DV Control panel in Chromeleon 6.8.

**NOTE** After the Dionex AS-DV stops its current operation, the carousel returns to the home position (position 1). Do not reach into the autosampler while the carousel is moving!

### 3.8.2 Specifying a Bleed

A bleed delivers excess sample (and any trapped air) from the vial to waste, before delivering the injection volume to the sample loop or concentrator column. Excess sample is any sample above the fill line on the vial (see Figure 2-7).

You can use either the injection valve or an optional high-pressure valve configured as an auxiliary valve to perform the bleed. For details about plumbing a high-pressure valve as a bleed valve, see Section 2.2.3.

**Enabling a Bleed**

1. If you are creating a new instrument method or program, go to the Sample Preparation Options page of the Instrument Method Wizard or Program Wizard (see Figure 3-8).

   If you are editing an existing instrument method or program, go to the Sample Preparation page of the Instrument Method Editor or Program Editor.

2. If you are using **Basic Edit Mode**: In the **Bleed** list, select the valve position that will direct the bleed to waste. For the typical injection valve plumbing, select **InjectPosition** (see Figure 3-8). For the typical auxiliary valve plumbing, select **AuxValve.A** (see **Section 2.2.3**).
Figure 3-9). For suggested valve plumbing connections, see “Plumbing the Optional Valve” on page 92.

Figure 3-8. Sample Preparation Options (Chromeleon 6.8 Version Shown): Bleed Enabled Using the Injection Valve
Selecting Bleed adds two commands to the Command/Parameters table (see Figure 3-8 and Figure 3-9):

- The valve command switches the valve position to direct the bleed volume to waste.
- The DeliverSample Volume=Bleed command delivers the excess sample and trapped air from the vial to the valve.

3. If you are using Advanced Edit Mode, manually add the two commands described above to the Command/Parameters table.
3.8.3 Specifying a Rinse

A rinse delivers rinse liquid from a vial to waste. To perform a rinse cycle, the Dionex AS-DV needs the following information:

- The position of the vial containing the rinse liquid
- The volume to use for rinsing

Defining a Rinse Cycle

1. If you are creating a new instrument method or program, go to the Sample Preparation Options page of the Instrument Method Wizard or Program Wizard (see Figure 3-8).

   If you are editing an existing instrument method or program, go to the Sample Preparation page of the Instrument Method Editor or Program Editor.

2. If you are using Basic Edit Mode: Select the Rinse check box and enter the Volume (see Figure 3-10). With this mode, the rinse is always delivered from the vials in the rinse vial range specified in the Chromeleon 7 Instrument Configuration Manager or Chromeleon 6.8.
Server Configuration program (see “Specifying the Rinse Vial Position” on page 45).

Figure 3-10. Sample Preparation Options (Chromeleon 6.8 Version Shown): Deliver Rinse in Basic Edit Mode
Selecting the **Rinse** check box and entering a **Volume** adds two commands to the beginning of the **Command/Parameters** table (see **Figure 3-10**):

- The **InjectPosition** command switches the valve position, directing the rinse volume to waste.

- The **DeliverRinse** command delivers the specified rinse **Volume** from the **Rinse** vial to the valve.

3. If you are using **Advanced Edit Mode**: Manually add the **InjectPosition** and **DeliverRinse** commands described above to the **Command/Parameters** table (see **Figure 3-11**). With this mode, you can deliver the rinse from any vial.

![Figure 3-11. Sample Preparation Options: Deliver Rinse in Advanced Edit Mode (Chromeleon 6.8 Version Shown)](image-url)
Specifying the Rinse Vial Position

This section describes two methods for specifying a rinse vial position.

**Method 1:** Specify a vial in the rinse vial range

1. To define the rinse vial range, start the Chromeleon 7 Instrument Configuration Manager or Chromeleon 6.8 Server Configuration program and open the AS-DV Properties dialog box. Click the **Options** tab. Under **Rinse Vial Range**, define a range of vial positions to be reserved for rinse vial use only (see Figure 3-12).

2. In the Chromeleon instrument method or program, enter **Rinse** for the vial position. See the example in Figure 3-10.

When the Dionex AS-DV performs the rinse, it takes the rinse liquid from the first vial in the rinse vial range. If the first vial is empty, the next vial in the range is used, and so on. If the specified rinse volume is greater than a single vial volume, the Dionex AS-DV takes the...
volume from more than one vial. Verify that the specified volume is available in the vials in the rinse vial range.

**Method 2:** Enter a specific vial position in the Chromelone instrument method or program.

1. On the Sample Preparation page of the Instrument Method Editor or Program Editor, select **Advanced Edit Mode**.

   **NOTE** When you open the Sample Preparation page in the Instrument Method Editor or Program Editor, Advanced Edit Mode is selected by default.

2. Enter a **DeliverRinse** command and enter the preferred vial position.

![Program File AS-DV - Sampler (AS-DV) Sample Preparation Options: (Chromelone 6.8 Version Shown) Deliver Rinse Example](image)
3.8.4 Returning to a Vial
After sampling from other vials, you can return to a vial that was previously sampled.

NOTE If a bleed is enabled, the Dionex AS-DV performs the bleed function when it returns to the vial. However, because the bleed was performed previously, there is no excess fluid remaining in the vial to exit during the second bleed cycle.

1. Open the sequence.
2. In the Position column, enter the position of the vial from which to take each sample. For example, in the example sequence shown in Figure 3-14, Sample 1 is taken from the vial in position 1. Samples 2 and 3 are taken from the vials in positions 2 and 3, respectively. For Sample 4, the Dionex AS-DV returns to the vial in position 1.

<table>
<thead>
<tr>
<th>No</th>
<th>Name</th>
<th>Type</th>
<th>Pos</th>
<th>Inj. Vol</th>
<th>Program</th>
<th>Method</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sample 1</td>
<td>Unknown</td>
<td>1</td>
<td>25.0 AS-DV</td>
<td>AS18_Trace</td>
<td>Single</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sample 2</td>
<td>Unknown</td>
<td>2</td>
<td>25.0 AS-DV</td>
<td>AS18_Trace</td>
<td>Single</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Sample 3</td>
<td>Unknown</td>
<td>3</td>
<td>25.0 AS-DV</td>
<td>AS18_Trace</td>
<td>Single</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Sample 4</td>
<td>Unknown</td>
<td>1</td>
<td>25.0 AS-DV</td>
<td>AS18_Trace</td>
<td>Single</td>
<td></td>
</tr>
</tbody>
</table>

Figure 3-14. Chromeleon Sequence Example (Chromeleon 6.8 Version Shown): Returning to a Vial

3.8.5 Replacing Vials During a Run
During a run, follow the steps below to remove vials that have already been sampled and replace them with different vials.

1. Open the Dionex AS-DV ePanel (in Chromeleon 7) (see Figure 3-4) or Control panel (in Chromeleon 6.8) (see Figure 3-5).
2. Under Reset Vial Memory, enter the Start Pos. and End Pos. of the range of vials that you want to replace. For example, if vials 1 through 10 have already been run and you want to replace them with new vials, enter 1 for the start position and 10 for the end position.
3. Click Reset Vial Range. This clears vial information (the size of the vial installed, if any, and the volume remaining) for the specified
positions. A message informs you that a queue or batch is currently running. Click Yes to continue.

4. Wait until the Dionex AS-DV carousel and sampling tip are not moving. Then lift the top cover, remove the old vials, and replace them with the new vials. **Do not reach into the autosampler while the carousel is moving!**

### 3.8.6 Inserting a Priority Sample

1. Open the currently running sequence.

2. To insert a priority sample, right-click the sample that you want the priority sample to precede and select Insert Sample. This adds a new sample to the sequence.

3. Enter injection information for the new sample and click File > Save.

4. If you are replacing a previously sampled vial with the priority vial, follow these steps:
   a. Open the Dionex AS-DV ePanel (in Chromeleon 7) (see Figure 3-4) or Control panel (in Chromeleon 6.8) (see Figure 3-5).
   b. Under **Reset Vial Memory**, enter the position of the vial in the Start Pos. and End Pos. boxes.
   c. Click **Reset Vial Range**. This clears vial information (the size of the vial installed, if any, and the volume remaining) for the position. A message informs you that a batch is currently running. Click Yes to continue.

5. Wait until the Dionex AS-DV carousel and sampling tip are not moving. Then lift the top cover, remove the old vial (if any), and insert the priority vial in the carousel. **Do not reach into the autosampler while the carousel is moving!**
3.8.7 Controlling the Delivery Volume

The Dionex AS-DV can deliver a full vial volume in one injection or deliver a partial vial volume in multiple injections. Sample delivery volume features vary, depending on the Edit Mode.

Controlling the Delivery Volume in Basic Edit Mode

1. On the Sample Preparation page of the Instrument Method Wizard/Editor or Program Wizard/Editor, select Basic Edit Mode (see Figure 3-15).

![Program File AS-DV Sampler (AS-DV)](image)

Figure 3-15. Sample Preparation Options: (Chromeleon 6.8 Version Shown)

Basic Edit Mode
2. In the **Volume** list, select the preferred option. The options available in **Basic Edit Mode** are:

- **From Sequence**: The Dionex AS-DV calculates the delivery volume using the formula shown in the **Total Volume Delivered Estimator**. See the example on [page 52](#).

- **Full**: The Dionex AS-DV delivers the full vial volume.

- **1666 µL**: The Dionex AS-DV delivers 1666 µL from the vial. Select this option if you want to take three injections from a 5000 µL vial.

- **2500 µL**: The Dionex AS-DV delivers 2500 µL from the vial. Use this option if you want to take two injections from a 5000 µL vial.

### Controlling the Delivery Volume in Advanced Edit Mode

1. On the Sample Preparation page of the Instrument Method Wizard/Editor or Program Wizard/Editor, select **Advanced Edit Mode**.

2. If you are creating a new instrument method or program, add a **DeliverSample** command to the list of commands in the **Command/Parameter** table.

3. If you are editing an existing instrument method or program, click the **Deliver Sample** command in the list.

4. In the **Volume** list, select the preferred option. The options available in **Advanced Edit Mode** are:

- **From Sequence**: The Dionex AS-DV calculates the delivery volume using the formula shown in the **Total Volume Delivered Estimator**. See the example on [page 52](#).

- **Bleed**: The Dionex AS-DV performs a bleed. For details about the bleed function, see “[Enabling a Bleed](#)” on [page 39](#).

- **Full**: The Dionex AS-DV delivers the full vial volume.

- **### µL**: The Dionex AS-DV delivers the specified number of µL from the vial. You can select the number of µL in 100 µL increments. For 5.0 mL vials, you can select from 100 to 5000 µL. For 0.5 mL vials, you can select from 100 and 500 µL.
For example, to take five injections from a filled 5.0 mL vial, select 1000 $\mu$L. In the instrument method Script or program Commands view, a `DeliverSample Volume=1000` command appears (see Figure 3-16).

![Figure 3-16. Chromeleon 6.8 Commands View Example: Deliver Multiple Injections Per Vial by Specifying the Volume](image)

**Notes:**

- The wizard adds the `DelayVolume` and `FlushFactor` commands to the instrument method or program automatically. However, they are ignored in this example. If a second `DeliverSample` command (without a specified volume) were included, the `DelayVolume` and `FlushFactor` commands would be used to calculate the volume for the second `DeliverSample` command.

- In the Script or Commands view, you can enter the `Volume` for the `DeliverSample` command in 1 $\mu$L increments. For example, to take three injections from a 5000 $\mu$L vial, enter the following command: `DeliverSample Volume=1666`. 
Example: Using the From Sequence Volume Option

When From Sequence is selected for the sample delivery volume, the Dionex AS-DV calculates the delivery volume using the formula shown in the Total Volume Delivered Estimator. In this case, the DeliverSample command is included without a specified volume.

In the example shown in Figure 3-17, the loop volume is 25 µL, the delay volume is 125 µL (the default), and the flush factor is 8. This provides a delivery volume of 1200 µL. This example allows four injections per filled 5.0 mL vial.

Notes:

- In Loop Mode, you can increase or decrease the delivery volume by entering a different Flush Factor.
• When you create the sequence (see Section 3.6), enter the volume of the loop installed on the injection valve in the Inj. Vol. box. The Dionex AS-DV always injects a full loop volume.

3.8.8 Using Sample Overlap Mode

The Dionex AS-DV can be configured to overlap sample preparation functions. This means that while data collection is occurring for one injection, the Dionex AS-DV performs the sample preparation steps for the next injection in the sequence. The overlapped steps include Dionex AS-DV commands that occur before the EndSamplePrep command in the instrument method or program.

For sample overlap to occur, the BeginOverlap command must also be present in the instrument method or program. When sample overlap mode is enabled (see page 55) and you use the Instrument Method Wizard or
Program Wizard, Chromeleon automatically adds the EndSamplePrep and BeginOverlap commands. See the example in Figure 3-18.

Figure 3-18. Chromeleon 6.8 Commands View Example: Sample Overlap Enabled
Enabling Sample Overlap Mode

In the Instrument Configuration Manager or Server Configuration program, open the Dionex AS-DV Properties dialog box and click the **Options** tab. Select the **Sample Overlap** check box (see Figure 3-19).

*Figure 3-19. Dionex AS-DV Configuration Properties: Options Tab Page with Sample Overlap Enabled*
3.9 **Routine Maintenance**

This section describes routine maintenance procedures that the user can perform for the Dionex AS-DV. Any maintenance procedures for the Dionex AS-DV that are not described here must be performed by Thermo Fisher Scientific personnel. For assistance, contact Technical Support for Dionex products. In the U.S. and Canada, call 1-800-346-6390. Outside the U.S. and Canada, call the nearest Thermo Fisher Scientific office.

3.9.1 **Periodic Maintenance**
- Periodically check the carousel and wipe up any spills.
- Periodically rinse off any dried spills.

3.9.2 **Annual Maintenance**
- Rebuild the optional high-pressure valve (see Section 5.5).
- Replace the sampling tip and the tubing between the tip and the valve. The Dionex AS-DV Preventive Maintenance Kit (P/N 072678) contains all of the components required. Instructions are included with the kit.
This chapter is a guide to troubleshooting problems that may occur while operating the Dionex AS-DV.

- **Section 4.1** describes the error messages displayed in the Chromeleon audit trail.
- **Section 4.2** through **Section 4.8** describe other operating problems and how to resolve them.

If you are unable to solve a problem by following the instructions here, contact Technical Support for Dionex products. In the U.S. and Canada, call 1-800-346-6390. Outside the U.S. and Canada, call the nearest Thermo Fisher Scientific office.

### 4.1 Alarms and Error Conditions

If any of the following alarm conditions occurs, an error message is displayed in the Chromeleon audit trail. Each error message is preceded by an icon that identifies the seriousness of the underlying problem (see the table below).

<table>
<thead>
<tr>
<th>Icon</th>
<th>Severity Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Warning</td>
<td>A message is displayed in the audit trail, but the current run is not interrupted.</td>
</tr>
<tr>
<td><img src="image" alt="Error" /></td>
<td>Error</td>
<td>A message is displayed in the audit trail and the system attempts to correct the problem (sometimes by using an alternative parameter). An Error never interrupts the current analysis; however, if it occurs during the Ready Check, the analysis will not be started.</td>
</tr>
<tr>
<td><img src="image" alt="Abort" /></td>
<td>Abort</td>
<td>A message is displayed in the audit trail and the running batch is aborted.</td>
</tr>
</tbody>
</table>
The table below lists the Dionex AS-DV error messages. For troubleshooting assistance, refer to the page indicated in the table.

<table>
<thead>
<tr>
<th>Alarms and Error Conditions</th>
<th>Default Severity Level</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attempt to deliver an invalid vial.</td>
<td>Error</td>
<td>page 59</td>
</tr>
<tr>
<td>Attempt to reset vials while needle is not home.</td>
<td>Warning</td>
<td>page 59</td>
</tr>
<tr>
<td>Commanded carousel position cannot be found.</td>
<td>Abort</td>
<td>page 59</td>
</tr>
<tr>
<td>The Carousel Engage switch is inhibited during deliver.</td>
<td>Warning</td>
<td>page 60</td>
</tr>
<tr>
<td>Carousel or needle is busy.</td>
<td>Abort</td>
<td>page 60</td>
</tr>
<tr>
<td>More rinse volume than remaining has been requested.</td>
<td>Abort</td>
<td>page 60</td>
</tr>
<tr>
<td>The motor speed is reduced to ¼ of the previous one because of excessive load.</td>
<td>Warning</td>
<td>page 60</td>
</tr>
<tr>
<td>Needle is jammed.</td>
<td>Abort</td>
<td>page 61</td>
</tr>
<tr>
<td>Not enough volume to deliver.</td>
<td>Error</td>
<td>page 61</td>
</tr>
<tr>
<td>Sample needle failed to reach destination.</td>
<td>Error</td>
<td>page 61</td>
</tr>
<tr>
<td>This command is not allowed at this stage because the autosampler is busy.</td>
<td>Abort</td>
<td>page 62</td>
</tr>
<tr>
<td>TTL triggered while another command is in progress.</td>
<td>Warning</td>
<td>page 62</td>
</tr>
<tr>
<td>Valve error.</td>
<td>Abort</td>
<td>page 62</td>
</tr>
<tr>
<td>The vial is misaligned during deliver.</td>
<td>Error</td>
<td>page 63</td>
</tr>
<tr>
<td>The vial size has been changed without resetting the carousel.</td>
<td>Warning</td>
<td>page 64</td>
</tr>
</tbody>
</table>
Attempt to deliver an invalid vial.

This error occurs if a vial is not placed in the position specified in the instrument method or program, or if the vial position has been reset after the vial is already depleted.

To troubleshoot:

1. Verify that a vial with a cap installed has been inserted into the specified position.
2. Verify that sample remains in the vial.
3. If the problem persists, contact Technical Support for Dionex products for assistance.

Attempt to reset vials while needle is not home.

This error occurs if you attempt to reset vial memory, either by pressing the Carousel Release button or clicking a Reset Vial Memory button on the Dionex AS-DV Control panel (see Figure 3-5), when the needle is down.

To troubleshoot:

1. Wait until the needle is raised (homed) before resetting vial memory.
2. If the problem persists, contact Technical Support for Dionex products for assistance.

Commanded carousel position cannot be found.

This error can occur if the carousel is jammed or the vial sensor has failed.

To troubleshoot:

1. Press the Carousel Release button to release the carousel.
2. Check the carousel for blockages (see Section 5.2).
3. If the problem persists, contact Technical Support for Dionex products for assistance.
The Carousel Engage switch is inhibited during delivery.

This error occurs if you press the Carousel Release button while a sample is being delivered.

To troubleshoot:
Wait for a function to finish before trying to release the carousel.

Carousel or needle is busy.

This error occurs if you send a command while the carousel or needle is performing a function.

To troubleshoot:
Wait for one function to finish before issuing a command to begin another.

More rinse volume than remaining has been requested.

This error occurs if there is not enough liquid in the vials in the rinse vial range or in the specified vial (if a single vial is specified for the rinse).

To troubleshoot:
1. Press the Carousel Release button to clear the error and reset the system.
2. Install filled vials in the rinse vial range or in the specified position.
3. Begin the sampling process again.

The motor speed is reduced to ¼ of the previous one because of excessive load.

This error occurs when the needle is jammed or there is excessive backpressure. The motor speed is reduced and the Dionex AS-DV attempts to continue delivery. If the problem persists, the run is stopped, and the “Needle is jammed” error message is displayed. For troubleshooting, refer to the “Needle is jammed” section below.
Needle is jammed.

This error occurs when the needle is jammed or there is excessive backpressure.

To troubleshoot:

1. Press the Carousel Release button to release the carousel and raise the needle. If the needle does not raise automatically, manually raise the needle (see Section 5.4).
2. Check for blockages.
3. Check for excessive backpressure (see Section 4.7).
4. If the problem persists, contact Technical Support for Dionex products for assistance.

Not enough volume to deliver.

This error occurs when there is insufficient liquid in the vial to deliver the requested volume.

To troubleshoot:

Add more sample to the vial or select a smaller volume in Chromeleon (see Section 3.8.7).

Sample needle failed to reach destination.

This error occurs when the carousel is blocked or the sample head is jammed.

To troubleshoot:

1. Remove the carousel (see Section 5.2) and examine for blockages.
2. If the problem persists, replace the sampling tip (see Section 5.3).
3. If the problem continues, contact Technical Support for Dionex products for assistance.
This command is not allowed at this stage because the autosampler is busy.

This error occurs when a command is sent while the autosampler is performing another function.

To troubleshoot:
Wait for one function to finish before issuing a command to begin another.

TTL triggered while another command is in progress.

This error occurs if a controlling device sends a signal to the TTL input while the Dionex AS-DV is already performing a command.

To troubleshoot:
1. After the other command is completed, send the signal to the TTL input again. For details about the time required to complete the sample load cycle, refer to Section C.1.1.
2. If the problem persists, contact Technical Support for Dionex products for assistance.

Valve error.

This error occurs if the optional high-pressure valve is not connected properly or if the valve fails to switch position within 1 second of being toggled.

To troubleshoot:
1. Check the valve connections:
   a. Start the Chromeleon 7 Instrument Configuration Manager or the Chromeleon 6.8 Server Configuration program:
      • For Chromeleon 7, click Start on the Windows taskbar and click All Programs > Chromeleon 7 > Instrument Configuration Manager.
      • For Chromeleon 6.8, click Start on the Windows taskbar and click All Programs > Chromeleon > Server Configuration.
b. In the instrument or timebase, double-click the Dionex AS-DV icon to open the Dionex AS-DV Properties dialog box.

c. Select the **Options** tab. If the **Valve Injection** and **Auxiliary** options are unavailable, the valve is probably not connected properly.

d. Remove the valve (see [Section 5.6](#)) and verify that the cable connection is secure. When reinstalling, be sure to tighten the screws connecting the valve to the chassis to prevent any movement.

2. Toggle the valve positions:

   a. If a sequence is being executed, terminate the sequence by clicking **Batch > Stop** on the Chromeleon menu bar.

   b. Turn off the Dionex AS-DV power briefly and then restart.

   **NOTE** Turning off the Dionex AS-DV power does not reset vial memory.

   c. On the Dionex AS-DV ePanel or Control panel, try to toggle the valve position by clicking first the **Load Position** (or **Position A**) button and then the **Inject Position** (or **Position B**) button.

3. If the error recurs, rebuild the valve (see [Section 5.5](#)).

**⚠️ The vial is misaligned during deliver.**

This error occurs if the carousel jams or the vial sensor fails.

**To troubleshoot:**

1. Press the **Carousel Release** button to release the carousel.

2. Check that the vial has been inserted completely into the carousel and there is nothing blocking the vial.

3. Remove the carousel and check for blockages (see [Section 5.2](#)).

4. If the problem persists, contact Technical Support for Dionex products for assistance.
The vial size has been changed without resetting the carousel.

This error occurs if there is a discrepancy between the vial size installed in the carousel and the vial size currently stored in Dionex AS-DV memory. (For example, a 5.0 mL vial is installed in position 10, but the Dionex AS-DV expects a 0.5 mL vial to be installed in that position.) Vial memory must be reset before starting a new run.

To troubleshoot:

1. Before starting a new run, press the Carousel Release button to reset the vial memory.
2. If you want to replace vials during a run, use the controls on the Dionex AS-DV ePanel (in Chromeleon 7) or Control panel (in Chromeleon 6.8) under Reset Vial Memory to reset the memory for only the vials you want to replace. For instructions, see Section 3.8.5.
3. If the problem persists, contact Technical Support for Dionex products for assistance.

**IMPORTANT** Before starting a run, always press the Carousel Release button to disengage the carousel and reset vial memory. After loading the vials in the carousel, press the Carousel Release button again to engage the carousel.

During a run, do not press the Carousel Release button. Doing so clears all current vial information from Dionex AS-DV memory. During a run, the Dionex AS-DV stores the vial size installed in each carousel position and the remaining volume in each vial.

### 4.2 Liquid Leaks

- **Old, previously-used caps or sample vials**
  
  Do not reuse caps or sample vials.

- **Damaged tubing between sampling tip and optional high-pressure valve in the Dionex AS-DV or injection valve in the IC system**

  Replace the sampling tip and tubing (see Section 5.3).
• **Loose or damaged fitting connection(s) to optional high-pressure valve in the Dionex AS-DV or injection valve in the IC system**

1. Make sure the liquid lines to the valve are tight. Replace any damaged fittings. See Section 5.1 for tightening requirements.

2. Liquid leaks from behind the valve stator may indicate a scratched rotor seal. Rebuild the injection valve (see Section 5.5). **Do not overtighten!**

### 4.3 Poor Peak Reproducibility

• **Insufficient sample in sample vial**

Always be sure to fill each vial with enough sample to reach the fill line (see Section 3.1). Underfilling a vial will result in a smaller than normal volume for the first injection and will increase the risk of injecting air.

If the problem continues, overfill the vial slightly. After pushing the cap into the vial, gently tap any excess liquid from the fill cap socket.

• **Bleed function not turned on when loading a concentrator column**

Before loading concentrator column, check that **Bleed** is selected in Chromeleon (see Section 3.8.2). This ensures that a uniform sample volume is delivered to the concentrator, regardless of how accurately the vials are filled. Bleed also prevents the introduction of air onto the concentrator column. It does not, however, compensate for underfilling a sample vial.

• **(TTL Input Control Only) Injection not made during homing delay before sample tip is retracted from sample**

1. Always switch the injection valve to Inject before the end of the homing delay following the last sample in the vial (see Section C.1). Otherwise, the needle may create a vacuum when it withdraws from the vial and remove some or all of the sample from the sample loop.

2. Make sure that the injection valve is in Load whenever a sample delivery is in progress.
• **Liquid leak**
  1. Do not reuse caps or sample vials.
  2. Inspect the lip and socket of each new cap for irregularities, nicks, scratches, or other damage that might interfere with sealing as the cap is pushed into the vial.
  3. Make sure that the sampling tip is not damaged. Replace the tip if it is scratched, damaged, plugged, or restricted in any way (see Section 5.3).

• **Dissolved gas in samples**

  If the sample contains dissolved gas, it will produce peak area reductions. You can observe bubbles in the sample line during injections.
  1. Degas your sample with a vacuum filter or sonicate the samples.
  2. Before sampling from the vial, perform a bleed to direct excess sample and any air trapped in the vial to waste. For instructions, see Section 3.8.2. The bleed can be performed using either the injection valve or an optional high-pressure valve.
  3. If you are making multiple injections per vial, make them sequentially. This allows the needle to remain in the vial between injections, thus preventing air from entering the sample.

### 4.4 Unexpected or Extraneous Peaks Detected

• **Sample contaminated**
  1. Never reuse sample vials and caps.
  2. Always rinse new PolyVials and caps with deionized water before filling, especially when doing trace-level analyses (see Section 3.1).
  3. Run a rinse between samples, especially if samples are very different from each other.

### 4.5 Sample Not Loaded

• **TTL input not connected (if used)**

  During remote operation, make sure the TTL input cable is securely connected (see Appendix C).
• **USB cable not connected**

Make sure the USB cable is securely connected between the Dionex AS-DV and the Chromeleon PC or IC system.

• **Vial not sensed**

1. Make sure that a cap is installed in each PolyVial. Vials without caps are sensed as empty positions (see Section 2.2.1).
2. The vial detection sensors are blocked, dirty, or faulty. Contact Technical Support for Dionex products for assistance.

### 4.6 Autosampler Stops Operating

• **Sample loading backpressure exceeds 690 kPa (100 psi)**

Refer to Section 4.7 to isolate and eliminate the source of backpressure.

• **Autosampler is jammed**

In the event of a jam, the alarm will flash and an error will be recorded in the Chromeleon audit trail. See Section 4.8 for troubleshooting.

### 4.7 Excessive Backpressure

• **Injection valve in wrong position**

On the Dionex AS-DV ePanel (in Chromeleon 7) or Control panel on the panel tabset (in Chromeleon 6.8), toggle the valve position.

• **Restriction in the liquid flow path**

1. If the high backpressure persists, follow the liquid flow path backward from the injection valve, through the high-pressure valve (if installed), loosening fittings and reconnecting them until you locate the restriction.
2. If the restriction is in the optional high-pressure valve or the injection valve of the IC system, disassemble the valve and rebuild it (see Section 5.5). Inspect the port faces and replace them if necessary (see Section 5.6).
3. If the restriction is in the sampling tip (or the tubing between the valve and the sampling tip), replace the sampling tip (see Section 5.3).
Sample is viscous

Reduce the delivery speed by 20% or more in the Chromeleon instrument method or program (see Section 3.5).

4.8 Autosampler Jammed

Vial carousel is jammed

1. Press the Carousel Release button to try to home the carousel.
2. Remove the carousel (see Section 5.2) and check for foreign objects.

Sampling tip jams as it is being withdrawn

1. Check for excessive backpressure (see Section 4.7).
2. Check the sampling tip for possible obstruction:
   a. Turn off the power to the Dionex AS-DV.
   b. Manually raise the sampling head (see Section 5.4).
   c. Check for blockages.
This chapter describes Dionex AS-DV service and repair procedures that users may perform. Procedures not included here, including electronics-related repair procedures, must be performed by Thermo Fisher Scientific personnel. For assistance, contact Technical Support for Dionex products. In the U.S. and Canada, call 1-800-346-6390. Outside the U.S. and Canada, call the nearest Thermo Fisher Scientific office.

Before replacing any part, refer to the troubleshooting information in Chapter 4 to correctly identify the cause of the problem.

### 5.1 Replacing Tubing and Fittings

The Dionex AS-DV is plumbed with the needle and tubing assembly listed below:

<table>
<thead>
<tr>
<th>Tubing Assembly</th>
<th>Used for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dionex AS-DV Sampling Tip Kit (P/N 071575)</td>
<td>Connection from sampling head to injection valve</td>
</tr>
</tbody>
</table>

Dionex AS-DV tubing connections use high-pressure 10-32 fitting bolts (P/N 074449) and high-pressure double-cone ferrules (P/N 074373).

To tighten a high-pressure fitting bolt and ferrule:

1. Use your fingers to tighten the fitting bolt as tight as you can.
2. Then, use a wrench to tighten the fitting an additional three-quarter turn (270 degrees).
3. If leaks occur, replace the fitting bolt, ferrule, and tubing.
5.2 Removing the Carousel

The following tools are needed to complete this procedure: #1 Phillips screwdriver, 3-mm Allen wrench, and 2.5-mm Allen wrench.

1. Press the Carousel Release button to raise the sampling tip to its fully up position.

2. Turn off the Dionex AS-DV power and disconnect the power cord. Raise the top cover.

3. Remove the Dionex AS-DV front cover by gripping the indentations at each side and pulling the cover straight off toward you.

4. Use a #1 Phillips screwdriver to remove the three flathead screws from the sampling head tower cover (see Figure 5-1). Lift up the cover to remove it.

Figure 5-1. Removing the Sampling Head Tower Cover
5. Use a 3-mm Allen wrench to remove the set screw on the sampling head (see Figure 5-2).

6. Pull slightly on the sample out line to gain a small amount of slack in the line. Then, slide the tubing out of the slot in the sampling head (see Figure 5-3).

7. Push down on the sampling head to move the needle into the carousel a small amount. Twist the needle to allow the sampling tip to exit through the opening in the sensor block.
8. Lift the needle out of the carousel and set it to the right (see Figure 5-4).

9. Use a 2.5-mm Allen wrench to remove the three screws on the sensor block (see Figure 5-5). Lift the sensor block off the carousel and set it to the right.
10. Unscrew the thumbscrew on the carousel, and lift the carousel out of the autosampler.

![Figure 5-6. Removing the Carousel](image)

11. Clear any blockages and clean the basin.

12. Align the holes on the bottom of the carousel with the pins on the top of the carousel shaft and reinstall the carousel. Replace the thumbscrew and hand tighten.

13. Slide the needle tubing back into the slot in the sampling head.

14. Reinstall the sensor block.

15. Align the flat sides of the sampling tip so that they fit through the opening in the sensor block.

16. Make sure that the needle is pushed as far as it will go up into the sampling head and then tighten the set screw firmly.

   **NOTE** The set screw must be very tight to secure the sampling needle.

17. Reinstall the sampling head tower cover.

18. Reinstall the front cover and close the top cover.

19. Reconnect the power cord and turn on the power.
5.3 Replacing the Sampling Tip and Tubing

A scratched or otherwise damaged sampling tip may result in poor transfer of liquid from the sample vial to the injection valve. Damage to the tubing between the tip and the injection valve may result in liquid leaks. If you replace the sampling tip, you must also replace the tubing between the tip and the injection valve or optional high-pressure valve.

The Dionex AS-DV Sampling Tip Kit (P/N 071575) contains all required parts.

The following tools are needed to complete this procedure: #1 Phillips screwdriver and 3-mm Allen wrench.

1. Disconnect the sample out line from the injection valve or optional high-pressure valve. Remove the fitting.

2. Press the Carousel Release button to retract the sampling tip to its fully up position.

3. Turn off the Dionex AS-DV power and disconnect the power cord. Raise the top cover.

4. Remove the Dionex AS-DV front cover by gripping the indentations at each side and pulling the cover straight off toward you.

5. Use a #1 Phillips screwdriver to remove the three flathead screws from the sampling head tower cover (see Figure 5-7). Lift up the cover to remove it.

![Figure 5-7. Removing the Sampling Head Tower Cover](image-url)
6. Use a 3-mm Allen wrench to remove the set screw on the sampling head (see Figure 5-8).

7. Pull slightly on the sample out line to gain a small amount of slack in the line. Then, slide the tubing out of the slot in the sampling head (see Figure 5-9).

8. Push down on the sampling head to move the needle into the carousel a small amount. Twist the needle to allow the sampling tip to exit through the opening in the sensor block.

9. Unscrew the sampling tip from the needle and pull out and discard the tip and tubing.

10. Locate the sampling tip assembly in the kit. This assembly consists of a length of tubing with a new sampling tip installed on one end.
11. Thread the free end of the tubing up through the needle and screw the tip into place on the needle.

12. Continue threading the free end of the tubing up through the sampling head and out the aperture on the front of the Dionex AS-DV.

13. Slide the needle into place and slide the sampling needle tubing back into the slot in the sampling head.

14. Align the flat sides of the sampling tip so that they fit through the opening in the sensor block.

15. Make sure that the needle is pushed as far as it will go up into the sampling head and then tighten the set screw firmly.

   **NOTE** The set screw must be very tight to secure the sampling needle.

16. Reinstall the sampling head tower cover.

17. Reinstall the front cover and close the top cover.

18. Reconnect the sample out line to the valve.

19. Reconnect the power cord and turn on the power.
5.4 Manually Raising the Sampling Head

Follow this procedure if you need to raise the sampling head out of the carousel manually (for example, to clear a needle jam).

The following tools are needed to complete this procedure: #1 Phillips screwdriver and 2.5-mm Allen wrench.

1. Turn off the Dionex AS-DV power and disconnect the power cord. Raise the top cover.

2. Remove the Dionex AS-DV front cover by gripping the indentations at each side and pulling the cover straight off toward you.

3. Use a #1 Phillips screwdriver to remove the three flathead screws from the sampling head tower cover (see Figure 5-1). Lift up the cover to remove it.

![Figure 5-10. Removing the Sampling Head Tower Cover](image)

Remove 3 screws
4. Insert a 2.5-mm Allen wrench into the screw on top of the sampling mechanism (see Figure 5-11) and turn the wrench clockwise. The needle begins moving up.

5. Continue turning the wrench until the top of the sampling head is even with the top of the sampling mechanism.

6. If you are clearing a needle jam, remove the obstruction from the carousel.

7. Turn the wrench counterclockwise to begin lowering the needle. Turn the wrench until the top of the sampling head is about 6 mm (1/4 in) below the top of the sampling mechanism (see Figure 5-12).

8. Reinstall the sampling head tower cover.

9. Reinstall the front cover and close the top cover.

10. Reconnect the power cord and turn on the power switch.
5.5 Rebuilding a High-Pressure Valve

Thermo Scientific recommends rebuilding the optional high-pressure valve annually or if problems occur and other troubleshooting steps do not resolve the problem. The Injection Valve Rebuild Kit (6-port valve, P/N 075973; 10-port valve, P/N 079054) contains all required parts.

NOTE Substitution of non-Dionex/Thermo Scientific parts may impair valve performance and void the product warranty.

NOTE If you prefer, you can replace the high-pressure valve “pod” (see Section 5.6) instead of rebuilding the valve.

The following tool is needed to complete this procedure: 3-mm Allen wrench.

1. Turn off the Dionex AS-DV power.

   \[\text{CAUTION}\] The Dionex AS-DV power must be turned off before you rebuild a valve. If the power is on when you disconnect or connect the valve cable, the Dionex AS-DV will be damaged.

2. Raise the top cover.

3. Remove the Dionex AS-DV front cover by gripping the indentations at each side and pulling the cover straight off toward you.

4. Disconnect each liquid line connected to the valve.
5. Remove the 6-port or 10-port high-pressure valve:
   a. Use a 3-mm Allen wrench to remove the two screws holding the valve assembly in place (see Figure 5-13).
   
   ![Figure 5-13. Removing the Valve Assembly](image)

   b. Slide the valve assembly partway out of the chassis, press the locking latch on the cable (see Figure 5-14), and disconnect the cable.

   ![Figure 5-14. Disconnecting the Valve Cable](image)

   c. Remove the valve assembly.

6. Follow the instructions provided in the Rebuild Kit to replace the rotor seal, isolation seal, and stator face.
7. Reinstall the valve assembly and reconnect all liquid lines.
8. Turn on the power to the Dionex AS-DV.
9. Start a test run to check for leaks from the valve. Tighten fittings as required.
10. Reinstall the front cover and close the top cover.

5.6 Replacing a High-Pressure Valve Pod

This procedure describes how to replace the mechanical parts (the “pod”) of an optional high-pressure valve.

NOTE Substitution of non-Dionex/Thermo Scientific parts may impair valve performance and void the product warranty.

The following tool is needed to complete this procedure: 3-mm Allen wrench.

1. Turn off the Dionex AS-DV power.

CAUTION The Dionex AS-DV power must be turned off before you replace a valve pod. If the power is on when you disconnect or connect the valve cable, the Dionex AS-DV may be damaged.

2. Raise the top cover.
3. Remove the Dionex AS-DV front cover by gripping the indentations at each side and pulling the cover straight off toward you.
4. Disconnect each liquid line connected to the valve.
5. Remove the 6-port or 10-port high-pressure valve:
   a. Use a 3-mm Allen wrench to remove the two screws holding the valve assembly in place (see Figure 5-15).

   ![Figure 5-15. Removing the Valve Assembly](image)

   b. Slide the valve assembly partway out of the chassis, press the locking latch on the cable (see Figure 5-16), and disconnect the valve cable.

   ![Figure 5-16. Disconnecting the Valve Cable](image)

   c. Remove the valve assembly.

6. Unscrew the black locking ring on the front of the valve (see Figure 5-15) and remove the ring.
7. Grasp the front of the valve pod and pull out firmly to remove it.

8. Align the slots in the new pod (6-port, P/N 075971; 10-port, P/N 075972) with the runner in the valve holder. Valve pods are keyed to fit only one way (one slot is narrower than the other). Verify that the slots are aligned with their matching runners.

9. Also verify that the two splines on the pod align with the matching splines inside the valve holder (see Figure 5-17). If necessary, twist the end of the pod to adjust the position of the splines.

10. Push the pod into the holder until it clicks into place. Replace the black locking ring.

11. Reinstall the valve assembly and reconnect all liquid lines.

12. Turn on the power to the Dionex AS-DV.

13. Start a test run to check for leaks from the valve. Tighten fittings as required.

14. Reinstall the front cover and close the top cover.
5.7 Replacing the Main Power Fuses

1. Turn off the power switch on the Dionex AS-DV rear panel (see Figure 5-18).
2. Disconnect the main power cord from both its source and from the Dionex AS-DV rear panel.

3. The fuse drawer is located below the main power switch (see Figure 5-18).
4. A recessed lock is located on each side of the fuse drawer. Use a small screwdriver (or your fingernail) to push each lock toward the center to release it. When both locks are released, pull the fuse drawer straight out of its compartment.
5. Replace the two fuses with new 3.15 A IEC 127 fast-blow fuses (P/N 954745). Thermo Scientific recommends always replacing both fuses.

6. Insert the fuse drawer into its compartment. Apply sufficient pressure evenly against the drawer to engage the two locks. The drawer will be flush against the panel when both locks are engaged.
7. Reconnect the main power cord and turn on the power.
A • Specifications

A.1 Electrical

Main Power
100 to 240 Vac, 50 to 60 Hz, 45 W
Typical input power: 15 W
Maximum line draw: 0.22 A at 110 Vac

Fuses
Two fast-blow IEC 127 fuses rated at 3.15 A (P/N 954745)

A.2 Physical

Dimensions
Width: 44.45 cm (17.5 in)
Height: 23 cm (9 in)
Depth: 56 cm (22 in)

Weight
16 kg (35 lbs)

A.3 Environmental

Operating Temperature
10 to 35 °C (50 to 95 °F)

Humidity
5% to 95% relative humidity, noncondensing
A.4 Sampling Mechanism

<table>
<thead>
<tr>
<th>Carousels</th>
<th>Sample Capacity</th>
<th>50 vials</th>
</tr>
</thead>
<tbody>
<tr>
<td>Materials</td>
<td>All wetted surfaces are chemically inert plastic (polypropylene, polyethylene, polytetrafluoroethylene, PEEK™, Tefzel®, or Kel-F®)</td>
<td></td>
</tr>
<tr>
<td>Delivery Type</td>
<td>Programmable in Chromeleon: From 0.1 mL/min to 5.0 mL/min</td>
<td></td>
</tr>
<tr>
<td>Number of Samples</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Minimum Volume Delivered</td>
<td>0.1 mL</td>
<td></td>
</tr>
<tr>
<td>Valve (Optional)</td>
<td>6-port or 10-port 2-position valve with PEEK wetted components; electrically-activated</td>
<td></td>
</tr>
</tbody>
</table>

A.5 Sample Vials

<table>
<thead>
<tr>
<th>Volume</th>
<th>0.5 mL and 5.0 mL, nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter (Optional)</td>
<td>20 μm, nominal</td>
</tr>
<tr>
<td>Material</td>
<td>Pharmaceutical-grade polypropylene vial and polyethylene cap, sintered polyethylene filter</td>
</tr>
<tr>
<td>Contamination Levels</td>
<td>Less than 3.0 ppb fluoride, chloride, nitrate, and phosphate; 8.0 ppb sulfate</td>
</tr>
<tr>
<td>Special Features</td>
<td>Concave cap directs air out of the vial; convex vial bottom mates with the cap to allow maximum delivery of sample</td>
</tr>
</tbody>
</table>
This chapter provides instructions for the initial installation of the Dionex AS-DV.

**NOTE** The order of the steps is important. It is especially important to install the Chromleon Chromatography Data System before connecting the USB cable and turning on the system power.

### B.1 Facility Requirements

- Make sure the Dionex AS-DV installation site meets the electrical and environmental specifications listed in Appendix A.
- Refer to the dimension specifications in Appendix A to determine the amount of bench space required. For optimum operation, place the Dionex AS-DV close as possible to the left side of the IC system.
- Allow at least 38 cm (15 in) of free space behind the Dionex AS-DV for connections and ventilation.
- Be sure that there is sufficient clearance above the Dionex AS-DV to allow the top cover to be opened or removed.

### B.2 Unpacking the Dionex AS-DV

1. Open the Dionex AS-DV shipping container. Remove the autosampler and place it on the workbench.
2. Unpack the Dionex AS-DV Ship Kit (for 0.5 mL vials, P/N AAA-071115; for 5.0 mL vials, P/N 068887) and all other items included in the shipping container. Place the items in a convenient location and check them against the packing list. Report any discrepancies to Thermo Fisher Scientific immediately.
3. Check the shipping container for any external signs of damage. If the container shows any sign of damage, contact Thermo Scientific immediately.

**IMPORTANT** Save the shipping container for later use. Should it be necessary to return the Dionex AS-DV during the warranty period, Thermo Fisher Scientific recommends repacking the autosampler in the original shipping container.

4. Repeat the steps above for any additional shipping containers.

**B.3 Connecting the Dionex AS-DV Sample Out Line**

**NOTE** To prevent possible contamination of the tubing and valve, Thermo Fisher Scientific recommends that you wear gloves while connecting the Dionex AS-DV sample out line.

1. Raise the Dionex AS-DV top cover.

2. Remove the Dionex AS-DV front cover by gripping the indentations at each side and pulling the cover straight off toward you.

   The sample out line is threaded through an aperture in the chassis (see Figure B-1).

![Sample Out Line](image)

*Figure B-1. Sample Out Line*
Two connection options are available:

- Connect the Dionex AS-DV sample out line directly to the injection valve in the IC system (see Section B.3.1).
- Connect the Dionex AS-DV sample out line to an optional 6-port or 10-port high-pressure valve installed in the Dionex AS-DV (see Section B.3.2).

### B.3.1 Connecting the Sample Out Line Directly to an IC System

1. Route the sample out line through the side slot in the Dionex AS-DV chassis. Leave a little slack in the tubing.

![Figure B-2. Routing the Dionex AS-DV Sample Out Line to an IC System](image)

2. Locate a 10-32 fitting bolt (P/N 074449) and double-cone ferrule (P/N 074373) in the Dionex AS-DV Ship Kit (for 0.5 mL vials, P/N AAA-071115; for 5.0 mL vials, P/N 068887).

3. Install the fitting and ferrule onto the end of the Dionex AS-DV sample out line. See Section 5.1 for installation and tightening requirements.
4. Connect the Dionex AS-DV sample out line to the sample in port on the IC system injection valve (see Figure B-3).

5. Replace the front panel and close the top cover on the Dionex AS-DV.

Go on to Section B.4.

B.3.2 Connecting the Sample Out Line to the Optional High-Pressure Valve

Installing the Optional Valve

1. Verify that the power to the Dionex AS-DV is off.

   The Dionex AS-DV power must be turned off before you install a valve. If the power is on when you connect or disconnect the valve cable, the Dionex AS-DV will be damaged.

2. Use a 3-mm Allen wrench to remove the two screws holding the valve cover plate to the chassis. Save the screws.
3. Reach inside the recess and gently pull the electrical cable until it extends out the front of the autosampler.

4. Remove the 6-port or 10-port valve from the Dionex AS-DV Valve Kit (6-port, P/N 068920; 10-port, P/N 068921).

5. Align the electrical cable with the connector on the back of the valve (see Figure B-4).

6. Press the cable’s locking latch and insert the cable into the connector on the valve until you hear a click.

7. Slide the valve assembly into the valve recess, making sure not to pinch the cable.

8. Use the two screws you removed from the valve cover plate to secure the valve onto the chassis. Hand tighten.
Plumbing the Optional Valve

The plumbing configuration for the valve depends on the components to be connected and the intended function. This section provides instructions for the following configurations:

- Plumbing the 6-port valve as an injection valve (see Figure B-5).
- Plumbing the 6-port valve as a bleed valve (see Figure B-6).
- Plumbing the 10-port valve as a bleed valve (see Figure B-7).

For information about plumbing the valve for other functions, refer to the appropriate Thermo Scientific Dionex Application Note.

![Figure B-5. 6-Port Valve Plumbing for Injection Valve](image)

![Figure B-6. 6-Port Valve Plumbing for Bleed Valve](image)
1. Connect the waste line:
   a. Remove the 2-meter (78-inch) length of 0.76-mm (0.030-in) ID
      green PEEK waste line (P/N 044777), the three double-cone
      ferrules, and the three 10-32 fitting bolts from the Dionex AS-DV
      Valve Kit.
   b. Install a fitting and ferrule onto the end of the waste line. See
      Section 5.1 for installation and tightening requirements.
   c. Connect the waste line to the appropriate port on the valve:
      For a 6-port injection valve, connect the waste line to port 2.
      For a 6-port bleed valve, connect the waste line to port 6.
      For a 10-port bleed valve, connect the waste line to port 8.
   d. Route the other end of the waste line to a waste container. Make
      sure that the outlet of the waste line is below the level of the
      Dionex AS-DV and is not elevated at any point.

2. Connect the Dionex AS-DV sample out line:
   a. Install a fitting and ferrule onto the end of the Dionex AS-DV
      sample out line.
   b. Connect the sample out line to the appropriate port on the valve:
      For a 6-port injection valve, connect the sample out line to port 3.
      For a 6-port bleed valve, connect the sample out line to port 5.
      For a 10-port bleed valve, connect the sample out line to port 7.

3. Complete the plumbing for bleed valve operation:
a. Install a fitting and ferrule onto one end of the line that will connect the Dionex AS-DV valve to the injection valve. If you are creating this line, use tubing appropriate for your IC system.

b. Connect the line to the appropriate port on the Dionex AS-DV valve:
   For a 6-port valve, connect the line to port 4.
   For a 10-port valve, connect the line to port 6.

c. Connect the other end of the line to the sample inlet port on the injection valve in the IC system. Use a fitting and ferrule appropriate for your IC system.

4. To complete the 6-port valve plumbing for injection valve operation, refer to Figure B-5 and to the manual for the IC system.

5. Replace the front cover and close the top cover on the Dionex AS-DV.

Go on to Section B.4.

B.4 Connecting the Drain Line

1. Locate the corrugated drain hose (P/N 055075) in the Dionex AS-DV Ship Kit.

2. Push the hose onto the **DRAIN** port on the Dionex AS-DV rear panel. Make sure the hose is pushed securely onto the port.

3. Place the free end of the hose into a waste container or appropriate drain.

4. Make sure that the outlet of the drain line is below the level of the Dionex AS-DV and is not elevated at any point.
B.5 Installing Chromeleon and the Chromeleon Software License

Before proceeding, verify that Chromeleon is installed on the PC and the Chromeleon software license is installed. For instructions, refer to *Installing the Chromeleon Chromatography Management System with a Dionex Ion Chromatograph (IC)* (Document No. 031883). The manual is shipped with Chromeleon.

B.6 Connecting the Dionex AS-DV to the Chromeleon PC

**IMPORTANT**

Do not turn on the power to the Dionex AS-DV until after you connect the USB cable.

Before connecting the USB cable, verify that Chromeleon is installed on the PC. If not, Windows will be unable to identify the new USB device when the power is turned on.

1. Locate the USB cable (P/N 960777) in the Dionex AS-DV Ship Kit.
2. Connect the USB cable (P/N 960777) between the USB connector on the Dionex AS-DV rear panel and either a USB port on the Chromeleon computer or a USB port on the host IC system.

A USB 2.0 external hub can be used to connect the Dionex AS-DV to the PC. Refer to the manual provided by the hub vendor for complete installation instructions. One or more hubs is required in the following situations:

- Use a hub if the number of USB devices in the system exceeds the number of available USB ports.
- Use a hub if the Dionex AS-DV is more than 5 meters (16 ft) from the PC.

**IMPORTANT**

The USB standard limits the USB cable length to 5 meters (16 ft). Each USB device can be separated from the PC by no more than five hubs. Thus, each USB device can be located no more than 30 meters (32 yds) from the PC.
B.7 Connecting the Power Cord

1. Verify that the power switch on the rear panel of the Dionex AS-DV is turned off. (The power switch may be turned on accidentally when the module is unpacked.)

2. Connect the power cord (IEC 320 C13) (ordered separately) from the main power receptacle on the rear panel to a grounded power source. The Dionex AS-DV power supply is auto-sensing, so no adjustment is required to select the line voltage.

**WARNING**

SHOCK HAZARD—To avoid electrical shock, use a grounded receptacle. Do not operate the Dionex AS-DV or connect it to AC power mains without an earthed ground connection.

The power supply cord is used as the main disconnect device. Make sure the socket-outlet is located near the Dionex AS-DV and is easily accessible.

**CAUTION**

Operation at AC input levels outside of the specified operating voltage range may damage the Dionex AS-DV.

**MISE EN GARDE**

DANGER D'ÉLECTROCUTION—Pour éviter toute électrocution, il faut utiliser une prise de courant avec prise de terre. Ne l'utilisez pas et ne le branchez pas au secteur C.A. sans utiliser de branchement mis à la terre.

Le cordon d'alimentation principal est utilisé comme dispositif principal de débranchement. Veillez à ce que la prise de base soit située/installée près du module et facilement accessible.

**WARNUNG**

STROMSCHLAGGEFAHR—Zur Vermeidung von elektrischen Schlägen ist eine geerdete Steckdose zu verwenden. Das Gerät darf nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen werden.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung. Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und leicht zugänglich ist.
B.8 Setting Up Chromeleon

This section provides brief instructions for setting up Chromeleon. For details about any of these steps, refer to the Chromeleon Help and to *Installing the Chromeleon Chromatography Management System with a Dionex Ion Chromatograph (IC)* (Document No. 031883).

B.8.1 Installing the Dionex AS-DV Device Driver

1. If you have not already done so, turn on the PC power.

2. For a local PC: Log onto Windows XP or Windows Vista as an administrator.
   For a network PC: Log on as a user with local PC administrator privileges.

3. If Chromeleon 7 is installed, check the Instrument Controller Service icon on the Windows taskbar and start the service, if it is not already running:
   • If the icon is gray, the Instrument Controller Service is running (idle).
   • If the icon is crossed out in red, the Instrument Controller Service is not running. Right-click the icon and click *Start Chromeleon Instrument Controller*. The icon changes to gold to indicate that the Instrument Controller Service is starting.

4. If Chromeleon 6.8 is installed, check the Server Monitor icon on the Windows taskbar and start the server, if it is not already running:
   • If the icon is gray, the server is already running (idle).
   • If the icon is crossed out in red, the server is stopped. To start the server, right-click the icon and select *Start Server*. The icon changes to gold to indicate that the Chromeleon 6.8 Server is starting.

5. Press the power switch on the Dionex AS-DV rear panel to turn on the power.

6. Windows automatically detects the new USB devices. A message flashes on the screen to inform you that new hardware was found.
7. The Found New Hardware Wizard appears. This wizard installs the new hardware into the Windows Device Manager.

8. Complete the wizard by selecting the following options:
   - If asked whether Windows can connect to Windows Update to search for software, select **No, not this time**.
   - Accept the default option (**Install the software automatically**) and click **Next >**. It is not necessary to insert a hardware installation disk.

**B.8.2 Configuring the Dionex AS-DV in Chromeleon**

1. Start the Chromeleon 7 Instrument Configuration Manager or the Chromeleon 6.8 Server Configuration program:
   - For Chromeleon 7, click **Start** on the Windows taskbar and click **All Programs > Chromeleon 7 > Instrument Configuration Manager**.
   - For Chromeleon 6.8, click **Start** on the Windows taskbar and click **All Programs > Chromeleon > Server Configuration**.

2. Add the Dionex AS-DV to an existing instrument or timebase or create a new instrument or timebase.
3. In the Dionex AS-DV Properties dialog box, click the Options tab (see Figure B-8).

![Dionex AS-DV Autosampler](image)

**Figure B-8. Dionex AS-DV Properties Dialog Box: Options Tab Page**

4. If a high-pressure valve is installed, select the function for which the valve will be used:
   - To use the valve as an injection valve, click **Injection**.
   - To use the valve for another function (for example, a bleed valve), click **Auxiliary**.

5. Change other options as required for your system. For information about the other options, click the Help button.

6. When the configuration is complete, select **File > Save Installation**.

7. Exit the program.
B.8.3 Connecting to the ePanel Set or Panel Tabset

Connecting to the Chromeleon 7 ePanel Set

1. To start the Chromeleon 7 client, click **Start > All Programs > Chromeleon 7 > Chromeleon 7**.

2. To display the AS-DV ePanel, click the **Instruments** category bar on the Console. Click your instrument in the Navigation Pane. Chromeleon 7 connects to the instrument and displays the ePanel Set. Click the **AS-DV** tab (see Figure B-9).

![Figure B-9. Example Chromeleon 7 ePanel Set: Dionex AS-DV ePanel](image-url)
Connecting to Chromeleon 6.8

1. To start the Chromeleon client, click **Start** and select **All Programs > Chromeleon > Chromeleon**.

2. To display the panel tabset, select **View > Default Panel Tabset** or click the **Default Panel Tabset** toolbar button.

3. To display the Dionex AS-DV Control panel, click the **AS-DV** tab (see **Figure B-10**).

![Figure B-10. Example Chromeleon 6.8 Panel Tabset: Dionex AS-DV Control Panel](image)
B.8.4 Verifying Chromeleon Communication

To verify that Chromeleon is communicating with the Dionex AS-DV:

1. On the Dionex AS-DV ePanel (in Chromeleon 7) or Control panel (in Chromeleon 6.8), under Settings, enter a Vial Position.

2. Under Commands, click Move to Vial. The carousel should move to the entered position.

3. If an optional valve is installed: In Chromeleon 7, click the Inject Position and then the Load Position button. In Chromeleon 6.8, click the Position A and then the Position B button. You should hear the valve actuate as it changes position.

4. If the carousel or valve do not respond, check the Chromeleon audit trail for error messages. For troubleshooting information, refer to Section 4.1 in this manual or to the Chromeleon Help.

B.8.5 Setting Up the Dionex AS-DV for Simultaneous Injections

The simultaneous injection feature allows delivery of sample to two independent ion chromatography (IC) systems with one Dionex AS-DV and a computer running Chromeleon. The Dionex AS-DV and AS40 Simultaneous Injection Kit for ICS Systems (P/N 060258) provides the necessary parts and instructions for setting up this feature.
The 4-pin connector (see Figure C-1) on the rear panel of the Dionex AS-DV provides one relay output and one TTL input.

The relay output can be programmed in Chromeleon to switch any low-voltage device. Switched current must be no more than 200 mA at 5 VDC.

When connected to a controlling device, a signal from the device to the TTL input starts the load cycle. This allows the Dionex AS-DV to operate without Chromeleon control.

This appendix provides the following information:

- A description of the Dionex AS-DV TTL input control function (see Section C.1).
- Instructions for connecting the Dionex AS-DV relay output and TTL input (see Section C.2).
- Example connections to a previous generation of Dionex ion chromatograph, and instructions for controlling the Dionex AS-DV without Chromeleon (see Section C.3).
- Instructions for controlling the Dionex AS-DV relay output with Chromeleon (see Section C.4).
C.1 TTL Input Function

**TTL IN** allows the load cycle to be started via a contact-closure relay output or TTL output signal from a connected controlling device. When the input is triggered for the first time, the Dionex AS-DV performs a full vial delivery on vial position 1. When triggered again, the Dionex AS-DV performs a full vial delivery on vial position 2, and so on. If no vial is detected, an error occurs. Triggering the input again clears the error and moves the carousel to the next available vial.

C.1.1 Load Cycle Timing

To inject the sample at the correct time, it is important to know the length of time required to complete the load cycle. The injection valve should not be switched to the inject position until after the load cycle is complete. Several factors (including vial size and delivery speed) determine the time interval between the start of the load cycle and injection of the sample.

**Table C-1** lists the times required to complete four types of load cycles. Use these times to determine how long to wait after triggering **TTL IN** before switching the injection valve to inject. (Each time value listed allows a margin of error of approximately ± 0.2 minutes.)

<table>
<thead>
<tr>
<th>Vial Size</th>
<th>Type</th>
<th>Delivery Speed (mL/min)</th>
<th>Injection Per Vial (Full Vial)</th>
<th>Time (Min) Per Sample Load</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large (5.0 mL)</td>
<td>Loop</td>
<td>4.0</td>
<td>1</td>
<td>2.7</td>
</tr>
<tr>
<td></td>
<td>Concentrator</td>
<td>1.0</td>
<td>1</td>
<td>8.8</td>
</tr>
<tr>
<td>Small (0.5 mL)</td>
<td>Loop</td>
<td>1.6</td>
<td>1</td>
<td>1.3</td>
</tr>
<tr>
<td></td>
<td>Concentrator</td>
<td>0.4</td>
<td>1</td>
<td>3.4</td>
</tr>
</tbody>
</table>

**Table C-1. Dionex AS-DV Load Cycle Times**

C.1.2 Delivery Speed, Flush Factor, and TTL Homing Delay Settings

If the Dionex AS-DV has never been connected to Chromeleon, the following default settings for delivery speed, flush factor, and TTL homing delay are used:

- Delivery speed: 4.0 mL/min
• Flush factor: 10
• TTL homing delay: 90 sec

The TTL homing delay specifies the time delay before homing (raising) the needle after delivery. For information about the flush factor, see Section 3.5.2.

If the Dionex AS-DV has been connected to Chromeleon, the delivery speed, flush factor, and TTL homing delay last entered are used.

To change one of the options, you can connect the Dionex AS-DV to Chromeleon, change the option’s value, and then disconnect the Dionex AS-DV from Chromeleon.

C.1.3 TTL Input Control Modes

To accommodate different controlling devices, the Dionex AS-DV TTL input responds to four types of signals. The default control mode, normal edge, is compatible with the output signals provided by Dionex products.

If the device connected to the Dionex AS-DV does not send a normal edge signal, select the appropriate control mode. Refer to the documentation provided with the controlling device and the information below to determine the correct mode.

• Normal Edge: In normal edge operation, the negative (falling) edge of a signal turns on the action.

The function of the positive (rising) edge depends on the action: For on/off, or other actions that have two options, the rising edge turns off the action. However, for functions with only one option, the rising edge has no effect.

• Inverted Edge: The inverted edge mode works identically to the normal edge mode except that the positive and negative edges are reversed in function.
• **Normal Pulse**: In normal pulse operation, the negative (falling) edge of the TTL signal is the active edge and the positive (rising) edge is ignored.

A pulse width of 50 ms or more is guaranteed to be detected. A pulse width of 4 ms or less is guaranteed to be ignored. The action for pulse widths that are greater than 4 ms and less than 50 ms is undefined.

• **Inverted Pulse**: The inverted pulse mode operates identically to the normal pulse mode except that the positive and negative edges are reversed in function.

### Selecting the Control Mode

1. Start the Chromeleon 7 Instrument Configuration Manager or the Chromeleon 6.8 Server Configuration program:
   - For Chromeleon 7, click **Start** on the Windows taskbar and click **All Programs > Chromeleon 7 > Instrument Configuration Manager**.
   - For Chromeleon 6.8, click **Start** on the Windows taskbar and click **All Programs > Chromeleon > Server Configuration**.

2. Under the instrument or timebase, double-click the **Dionex AS-DV** icon.

   The Dionex AS-DV Properties dialog box appears.

3. Click the **TTL Inputs** tab and then press the **F2** key.
The Device Configuration dialog box appears (see Figure C-2).

![Device Configuration Dialog Box: Selecting the TTL Input Control Mode](image)

**Figure C-2.** Device Configuration Dialog Box: Selecting the TTL Input Control Mode

4. Select the TTL input control mode required by the controlling device from the **Mode** list.
C.2 Connecting to the Relay Output and TTL Input

1. Locate the twisted pair of wires (P/N 043598) and 4-position connector plug (P/N 923852) (see Figure C-3) in the Dionex AS-DV Ship Kit (for 0.5 mL vials, P/N AAA-071115; for 5.0 mL vials, P/N 068887).

![Figure C-3. 4-Position Relay TTL Connector Plug]

2. To connect to RELAY OUT, connect an active wire (red) to position 1 and a ground wire (black) to position 2. To connect to TTL IN, connect an active wire (red) to position 3 and a ground wire (black) to position 4.

   To attach a wire to the plug, strip the end of the wire (if it is not already), insert the wire into the plug, and use a screwdriver to tighten the locking screw.

   **IMPORTANT** When attaching wires to the connector plug, be careful not to allow stray strands of wire to short to an adjoining position on the connector.

3. Plug the connector into the 4-pin connector on the Dionex AS-DV rear panel (see Figure C-1).

4. Connect the wires from the Dionex AS-DV connector plug to the appropriate connector pins on the controlling device. Additional connector plugs are provided with other Dionex products.

   **NOTE** Check the polarity of each connection. Connect signal wires to signal (+) pins and ground wires to ground (-) pins. If you reverse the wires when connecting the relay output, the relay will not work correctly.

5. If you connected TTL IN, verify that the correct input control mode is selected (see Section C.1.3).
C.3 Example Connections for Stand-Alone Operation

This section provides an example of connecting the Dionex AS-DV to a previous generation of Dionex ion chromatograph. **Relay Out 1** on the Thermo Scientific Dionex IC20 Ion Chromatograph is used to control **TTL IN** on the Dionex AS-DV.

To control the Dionex AS-DV, set up a Dionex IC20 method that includes timed events for triggering **TTL IN** on the autosampler. **Figure C-5** illustrates the timed events in an example method.
C.4 Controlling the Relay Output

The Dionex AS-DV provides relay contacts for control of functions in external devices. The relay output can be programmed in Chromeleon to switch any low-voltage device. Switched current must be no more than 200 mA at 5 VDC. The relay-contact closures are normally open. When the relay is closed, current flows to the connected device.

**IMPORTANT** Relay loads in excess of 200 mA or with included power supplies over 5 VDC may damage the relay drivers on the CPU.

Use one of the following methods to control the relay output states: execute direct control commands or include the commands in an instrument method or program. Refer to the following instructions.
Controlling the Relay Output Directly Using Chromeleon 7
1. Open the ePanel Set (see Section 3.4.1) and press the F8 key.
   The Command window appears.
2. In the list of devices in the left pane, click Sampler_Relay.
3. In the right pane, click the Commands tab.
4. Click the required command (Closed or Open) (see the example in Figure C-6).

![Figure C-6. Chromeleon 7 Command Window: Relay Control Commands](image)

Controlling the Relay Output Directly Using Chromeleon 6.8
1. Open the panel tabset (see Section 3.4.2) and press the F8 key.
   The Commands dialog box appears.
2. Expand the list of commands under Sampler and then under Sampler_Relay.
3. Execute the required command (see the example in Figure C-6).

Figure C-7. Chromeleon 6.8 Commands Dialog Box: Example Relay Control Command
Controlling the Relay Output with an Instrument Method or Program

To add relay output control commands to a Chromeleon 7 instrument method, use the **Script Editor** (see Figure C-1).

![Figure C-1. Chromeleon 7 Script Editor](image_url)
In Chromeleon 6.8, you can enter the commands on the **Relay and State Devices Options** page in the Program Editor or Program Wizard (see Figure C-8).

![Program Wizard: Relay and State Devices Options](image)

**Figure C-8. Chromeleon 6.8 Program Wizard: Example Relay Output Control Command**
### D • Reordering Information

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Item Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vials, Caps, and Accessories</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>038141</td>
<td>PolyVials and filter caps, 5.0 mL</td>
<td>Pkg. of 250 (each)</td>
</tr>
<tr>
<td>038142</td>
<td>PolyVials and filter caps, 0.5 mL</td>
<td>Pkg. of 250 (each)</td>
</tr>
<tr>
<td>039532</td>
<td>PolyVials and plain caps (no filters), 5.0 mL</td>
<td>Pkg. of 250 (each)</td>
</tr>
<tr>
<td>042014</td>
<td>PolyVials and plain caps (no filters), 0.5 mL</td>
<td>Pkg. of 250 (each)</td>
</tr>
<tr>
<td>038008</td>
<td>PolyVials, 5.0 mL</td>
<td>Pkg. of 250</td>
</tr>
<tr>
<td>038010</td>
<td>PolyVials, 0.5 mL</td>
<td>Pkg. of 250</td>
</tr>
<tr>
<td>038009</td>
<td>Caps, filter, 5.0 mL</td>
<td>Pkg. of 250</td>
</tr>
<tr>
<td>038011</td>
<td>Caps, filter, 0.5 mL</td>
<td>Pkg. of 250</td>
</tr>
<tr>
<td>039528</td>
<td>Caps, plain (no filters), 5.0 mL</td>
<td>Pkg. of 250</td>
</tr>
<tr>
<td>079797</td>
<td>Caps, plain (no filters), 0.5 mL</td>
<td>Pkg. of 250</td>
</tr>
<tr>
<td>068947</td>
<td>Tray for 5.0 mL vials</td>
<td>1</td>
</tr>
<tr>
<td>068948</td>
<td>Tray for 0.5 mL vials</td>
<td>1</td>
</tr>
<tr>
<td>071901</td>
<td>Adapters for 0.5 mL vials</td>
<td>Pkg. of 50</td>
</tr>
<tr>
<td>037987</td>
<td>Tool, vial cap insertion</td>
<td>1</td>
</tr>
<tr>
<td><strong>Tubing and Fittings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>071575</td>
<td>Dionex AS-DV Sampling Tip Kit</td>
<td>2.5 cm (1 in)</td>
</tr>
<tr>
<td>074449</td>
<td>Fitting, bolt, 10-32</td>
<td>1</td>
</tr>
<tr>
<td>074373</td>
<td>Fitting, ferrule, double-cone</td>
<td>1</td>
</tr>
<tr>
<td><strong>Kits</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>068920</td>
<td>6-Port High-Pressure Valve Kit</td>
<td>1</td>
</tr>
<tr>
<td>068921</td>
<td>10-Port High-Pressure Valve Kit</td>
<td>1</td>
</tr>
<tr>
<td>060258</td>
<td>Dionex AS-DV and AS40 Simultaneous Injection Kit for ICS Systems</td>
<td>1</td>
</tr>
<tr>
<td>072678</td>
<td>Dionex AS-DV Preventive Maintenance Kit</td>
<td>1</td>
</tr>
<tr>
<td><strong>Miscellaneous Items</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>055075</td>
<td>Drain hose, convoluted, 10-mm (0.4-in) ID, 1.2 m (4 ft) long</td>
<td>1</td>
</tr>
<tr>
<td>Part Number</td>
<td>Item</td>
<td>Quantity</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>954745</td>
<td>Fuse, IEC 127, rated 3.15 A</td>
<td>1</td>
</tr>
</tbody>
</table>
# Index

## Numerics
- 10-port valve, 11  
  *See also* High-pressure valves
- 6-port valve, 11  
  *See also* High-pressure valves

## A
- Adapters for 0.5 mL vials, 10
- Advanced Edit Mode, 31, 34
- Alarm LED, 8
- Alarms, 57  
  *See also* Error messages
- Annual maintenance, 56
- AS-DV  
  - Front view, 7
  - Operating principles, 14
  - Overview, 1
  - Rear panel, 12
  - Ship Kit, 2
  - Software control, 1
  - Spare parts list, 115
- Audit trail, 8, 57
- Auxiliary valve, 11, 99  
  *See also* High-pressure valves

## B
- Backpressure, excessive, 67
- Basic Edit Mode, 31, 34
- BeginOverlap command, 53
- Bleed  
  - Description, 15
  - Performing, 39
- Bleed valve, 16 – 17  
  - Plumbing, 92 – 93
  *See also* High-pressure valves

## C
- Cables  
  - Power cord, 84
  - USB, 13, 95
- Carousel  
  - Description, 8
  - Loading, 25
  - Release button, 7, 9
  - Removing, 70
- Carousel Error Counter, 20
- Carousel LED, 8
- Caution icon, 3 – 4
- CE mark, 6
- cETLus mark, 6
- Chromeleon, 1  
  - AS-DV device driver installation, 97
  - AS-DV Properties dialog box, 99
  - Audit trail, 8, 57
  - Configuring the AS-DV in, 98
  - Connecting the AS-DV to the PC, 95
  - Connecting to the software, 26, 100
  - Control panel, 18 – 19, 27, 100
  - Creating a program, 30
  - Creating a sequence, 36
  - Creating an instrument method, 30
  - Error messages, 57 – 58
  - Installing, 95
  - Instrument methods, 19
  - License, 95
  - Panel tabset, 18 – 19, 27, 100
  - Programs, 19
  - Sequences, 36
  - User interface, 18
  - Verifying communication with, 102
  - Version required, 1
- Chromeleon Server Monitor, 28
- Cleaning vials, 21
- Commands
Creating a program, 19
Creating an instrument method, 19
Concentrator mode, 30
Connected LED, 8
Control panel
   AS-DV, 29, 101
Cycle Time, 32

D
Danger icon, 3 – 4
Declaration of Conformity, 6
Deionized water requirements, 5
Delay Volume, 32
Delivery speed, 32
Delivery volume, 49
   From sequence, 52
   In Advanced Edit Mode, 50
   In Basic Edit Mode, 49
Dimensions, 85
Drain port, 12
   Drain line connection, 94

E
Edit Mode, 31
Electrical specifications
   Fuses, 85
   Main power, 85
EndSamplePrep command, 53
Environmental specifications
   Humidity, 85
   Operating temperature, 85
ePanel
   AS-DV, 18
Error messages, 57 – 63
Extraneous peaks detected, 66

F
Facility requirements, 87
Filters, vial cap, 9
Fitting replacement, 69
Flow schematics
   High-pressure valves, 16
Flush Factor, 32
Front interior, 11
   Accessing, 11
Front view, 7
Fuses, 13
   Replacing, 84
   Requirements, 85

H
High-pressure valves, 11
   Configuring as a bleed valve, 17, 99
   Configuring as an auxiliary valve, 99
   Configuring as an injection valve, 99
   Configuring in Chromeleon, 99
   Controlling, 33 – 34
   Flow schematics, 16
   Installing, 90
   Operating principles, 15
   Operation, 16
   Plumbing, 92
   Rebuilding, 79
   Replacing mechanical parts (pod), 81
Humidity limits, 85

I
IC applications
   Deionized water requirements, 5
Icons used in manual, 3
Important icon, 3
Injection valve, 11, 99
   Plumbing, 92
   See also High-pressure valves
Installation instructions, 87
   Chromeleon connection, 95
   Chromeleon setup, 97
   Configuring the AS-DV in Chromeleon, 98
   Drain line connection, 94
Index

High-pressure valve installation, 90
Power cord connection, 96
Sample out line connection, 88
Simultaneous injection setup, 102
TTL and relay connectors, 108
Unpacking the AS-DV, 87
Instrument methods (Chromeleon), 19
  Creating, 30
  Creating instrument methods, 19
  General parameters, 32
  Loading a concentrator column, 30
  Loading a loop, 30
Interrupting the autosampler, 38
Inverted edge TTL input control, 105
Inverted pulse TTL input control, 106

J
Jammed autosampler, 68

L
Labels, safety, 5
Leaks, 64
LED display, 8
Load cycle timing, 104
Loop mode, 30

M
Main power receptacle, 13
Maintenance, 56
Messages
  Error, 58
  Safety, 3

N
Needle Error Counter, 20
Normal edge TTL input control, 105
Normal pulse TTL input control, 106

O
Operating features
  Front interior, 11
  Front view, 7
  Rear panel, 12
Operating principles, 14
  High-pressure valves, 15
  Rinsing, 15
Operating temperature, 85
Optional high-pressure valves, 11
Overlap Mode, 53

P
Parameters
  Chromeleon commands, 19
PGM file
  See Programs (Chromeleon)
Physical specifications
  Dimensions, 85
  Weight, 85
Plumbing the high-pressure valve, 92
PolyVials, 1, 9
  See also Vials
Poor peak reproducibility, 65
Power cord, 84, 96
Power LED, 8
Power receptacle, 13, 96
Power requirements, 85
Power switch, 13
Priority sample, 48
Programs (Chromeleon)
  Creating, 19, 30
  General parameters, 32
  Loading a concentrator column, 30
  Loading a loop, 30

R
Rear panel, 12
  Fuses, 13
  Power receptacle, 13
Power switch, 13
USB receptacle, 13
Rebuilding the high-pressure valve, 79
Regulatory information, 3
Relay output, 13
Connection instructions, 108
Controlling, 110
Description, 103
Reordering information, 115
Replacing the sampling tip, 74
Replacing tubing and fittings, 69
Replacing vials during a run, 47
Returning to a vial, 47
Rinse vial positions, 45
Rinses
Operating principles, 15
Performing, 42
Running, 38
Replacing vials during, 47

S
Safety icons, 3 – 5
Safety messages, 3 – 4
Safety symbols, 5
Sample out line, 11
Connecting, 88
Sample Overlap Mode, 53, 55
Sample vials
See Vials
Sampling head
Raising manually, 77
Sampling head tower, 8
Sampling mechanism, 8
Specifications, 86
Sampling tip, 14
Replacing, 74
Sensors, 8
Sequence Wizard (Chromeleon), 36
Sequences (Chromeleon), 36
Service procedures, 69
Fuse replacement, 84
High-pressure valve pod replacement, 81
Manually raising sampling head, 77
Sampling tip replacement, 74
Tubing and fittings replacement, 69
Ship Kit, 2
Simultaneous injections, 102
Spare parts list, 115
Specifications
Electrical, 85
Environmental, 85
Physical, 85
Sample vials, 86
Sampling mechanism, 86
Speed Adjustment Counter, 20
Stand-alone operation, 109
Starting a run, 38
Symbols, safety, 5
System Safety, 19

T
Technical Support, 3, 56 – 57, 69
Tool
Vial cap insertion, 9
Total Volume Delivered Estimator, 31, 52
Trace-level analyses, 22
Troubleshooting
Autosampler jammed, 68
Autosampler stops, 67
Error messages, 57
Excessive backpressure, 67
Leaks, 64
Sample not loaded, 66
TTL and relay connectors
Installation instructions, 108
TTL input, 13
Connection instructions, 108
Control modes, 105
Function, 103 – 104
Tubing replacement, 69
Index

U
Unexpected peaks detected, 66
Unpacking the AS-DV, 87
USB cable, 95
USB receptacle, 13

V
Valve Actuation Counter, 20
Valves
   See High-pressure valves
Vial adapters for 0.5 mL vials, 10
Vial caps, 9
   Cleaning, 22
   Filters, 9
   Insertion tool, 9
   Installing, 24
Vial Process Counter, 20
Vial sensors, 8
Vial tray, 10
Vials, 1, 9
   Cleaning, 21
   Filling, 23
   Preparing, 21
   Specifications, 86

W
Warning icon, 3 – 4
Warranty, voiding, 69
Weight, 85
Wellness, 19